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BATTLEGROUND: BULL RUN is an historical strategy game dealing with both epic Civil War battles at
Bull Run. These momentous battles were fought outside the Virginia town of Manassas in July, 1861 and
again in August, 1862. The battlefield is represented by a “hand-drawn” maps, taken from some of the most
detailed sources available. Aseries of battles, called scenarios, is presented for play on these maps. 

As an added feature, scenarios and a map for the Battle of Blackburn’s Ford (fought three days prior to
the first battle of Bull Run,) and Brawners Farm (fought the evening before the second battle,) have also been in-
cluded.
Game Scale. Each hexagon (hex) on the map represents an area 125 yards wide (a mile equals 14 hexes),
and each Game Turn represents twenty minutes in a dawn, daytime or dusk turn or one hour in a night turn.

ATTENTION!! VETERAN BATTLEGROUND GAMERS
BATTLEGROUND: BULL RUN is, in many ways, similar to the first six games in TalonSoft’s
BattlegroundTM series. The interface (the toolbar, menu options, 2D and 3D displays, etc.) all
conform to the standard BattlegroundTM style. More specifically, for veteran gamers of Battle-
ground: Gettysburg, Shiloh, or Antietam you’ll be able to move right into this game with little
or no problem. However, there are some new game play features which were introduced in
Battleground: Bull Run, we recommend you review these guidelines again.

Introduction
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1.0 INTRODUCTION



After picking a scenario to play (see 3.0 CHOOSING A SCENARIO), you and your computer or human
opponent maneuver, attack and defend with units representing regiments of infantry and cavalry (the
“S#” in the Unit List represents total number of soldiers) plus artillery batteries (each “S#” in the Unit
List represents one gun) and individual leaders. Your goal in each scenario is to either capture or hold
specific objectives, while trying to eliminate as many of the opponent’s units as possible. However,
you must also husband your own forces, for the casualties suffered by each side are added to the other
side’s victory-point total. For more details see 6.2 VICTORY CONDITIONS. For illustrations of all the unit
icons, see 5.1.

The visibility in a daytime turn is limited only by the presence of LOS (line of sight) obstacles. In
a dawn or dusk turn, visibility is limited to four hexes. In a night turn, each turn is one hour long and
visibility is restricted to one hex. To find out when each type of turn starts and ends, check the sce-
nario’s Parameter Data file (Select Scenario Notes from the Help pop-down menu).

Each Player Turn consists of four phases: Movement, Defensive Fire, Offensive Fire, and Melee.
Two consecutive Player Turns (one for each side) having the same turn number comprise a Game
Turn. When the specified number of Game Turns has been played, the scenario ends and the victor is
announced.

Each time you Select the “find next stack” Toolbox button, the program will move the
Hot Spot to a hex that has a unit which has not yet conducted an action in the current
phase. This lets you check for units you might have forgotten to move or fire before

going on to the next phase.

To advance the game to the next phase, Select the “advance to next phase” Toolbox button.

The Phase Box. At the start of each new phase, the
Phase Box appears to announce the phase and give
the current turn number. Left-click with the mouse
on the Box to begin the phase—or right-click on it to
begin the phase and make it disappear automatically
after a few seconds each time it appears afterwards.

HEX OUTLINES
The concept of “hexes” is very important to successfully grasping the fun-
damentals of movement and attack ranges. Since the hex outlines are “off”
by default at start, it is strongly recommended that you make them visible

by Selecting the Hex Outlines command in the Options menu when you begin your first game.

THE HOT SPOT
The red square- or rectangle-shaped indicator that appears on the map is known as the Hot Spot. The
hex currently containing the Hot Spot is called as the Hot Spot hex.

The Basics of Play
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THE TOOLBOX
The Toolbox enables you to conduct certain actions without having to use the pop-down menus.
Selecting a Toolbox button initiates the command associated with it. Some are explained here, but
for a full listing of its buttons and commands see 4.5 on p.30.

SELECTING UNITS
You must Select a unit before you can have it conduct an action. To do so, 

1. Select the hex the unit occupies by left-clicking with the mouse in that hex. Doing this will
make the selected hex the Hot Spot hex.

2. Left-click with the mouse in that units data area in the Unit List at the bottom of the screen.
(For an alternative method, see The Pop-Up Selection Dialog on p.28)

You can opt to Select more than one unit in a hex, which will enable you to move (or attack
with) all of them at the same time. All the units in a hex can be Selected at once by double-clicking
with the left mouse button in that hex.

If you right-click in a units data area in the Unit List, you will see its organizational information.

FORMATIONS & UNIT TYPES
The units in BATTLEGROUND: BULL RUN move and attack in several different “Formations” that were
used during the Civil War. Below are the unit types and their formation options.

Infantry is always in either line or column Formation. Line represents the men
lined up “shoulder-to-shoulder” for attacking or defending. Column represents
their being either in marching order or in “column of companies” attack formation. 
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Cavalry and leaders are always in either mounted or dismounted Formation.

Artillery is always in either limbered (i.e., hooked up to its horses and ammunition
caissons) or unlimbered (ready to fire) Formation. 

Note: Infantry in column, mounted cavalry/leaders and limbered artillery have an increased move-
ment allowance but cannot attack [Exception: infantry in column and mounted cavalry can engage in
Melee] and are more vulnerable to enemy attacks. Unlimbered artillery cannot move except to change
Facing within its hex.

Supply wagons are always in column Formation.

When can I Change a Unit’s Formation?
You can change a units Formation only during its Movement Phase. (IMPORTANT: Infantry and
dismounted cavalry can change Formation only before it begins to move. Once such a unit has
moved, you must wait until the next Movement Phase to change its Formation.) 

To change a units Formation,

1. Select the unit

2. Then, Select the “Change Formation” button in the Toolbox. To find how to tell what a
unit’s current Formation is, see Unit-List Icons on p27.

FACING
All units, regardless of their present Formation, have a
Facing—i.e., always face towards one of their hex’s
hexsides. A “hexside” is the line between two adjacent

hexes (see illustration below).

IMPORTANT: The current Facing of each regiment in line formation and unlimbered battery deter-
mines its Field of Fire (i.e., its directional ability to attack and defend); see 6.7 COMBAT. You do not
have to change a units Facing to move it.

You can change a unit’s Facing only during its Movement Phase. To change
its Facing, Select the unit, then Select one of the “change Facing” buttons in
the Toolbox. One button changes the Facing clockwise, one hexside at a

time; the button next to it does likewise but in a counter-clockwise direction; and the third button
makes the unit do an “about face”.

Aunit faces the hexside of a hex.
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MOVEMENT

There are basically three ways to move units:

Hex-by-Hex. One way to move a unit is to Select it, then right-click in a hex adjacent to it. You can
continue right-clicking in adjacent hexes until the unit either is where you wish it to stop or it can
move no further due to lack of sufficient movement points to enter another hex.

Drag-and-Drop. Another way is to use “drag-and-drop”. Select the unit, place the cursor on that
unit’s hex, press and hold down the left mouse button, move the cursor to the hex you wish to move
the unit to, and then release the mouse button. The program will move the unit from hex to hex for
you, using the path that costs it the least to take.

Auto Movement. A third way to move a unit is by Auto Movement. To use this method, Select the
unit, then hold down the Alt key and right-click in the hex you wish that unit to move to. The pro-
gram will move the unit from hex to hex for you, using the path that costs it the least to take.
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Each hex a unit moves into, each Formation change a  unit makes (Exception: leaders do not pay
to mount or dismount), and each Facing change made by infantry in line or dismounted cavalry, costs it
a portion of its movement allowance; these costs are listed under Change Costs in Parameter Data,
which can be found by Selecting Scenario Notes in the Help menu. See also 6.1 TERRAIN for the ef-
fects of terrain (including roads, etc.) on movement.

Unless Fog of War is in effect for the opposing side, the most recent movement (or Facing/For-
mation change) made by a unit can be undone by holding down the Ctrl key and pressing U, provid-
ed that unit is still Selected.

Selecting either the “highlight moved units” Toolbox button or the Moved Units command in
the Display menu will highlight all units that have moved thus far in the Movement Phase.

Column Movement
You can use column movement to move, as a single entity, a group of units that are stacked together
and/or in a string of adjacent hexes. There are two types of column movement: organization and
chain.

Organization. To conduct organization column movement, 

1. Select the hex occupied by the “leading” unit. 

2. Then Select a unit in that hex, hold down the Ctrl key and right-click in the adjacent hex you
wish that unit to move to. 

As it moves, all units in the group that belong to the Selected unit’s organization (brigade, division,
etc.) will follow it. (To see a unit’s organizational information, right-click in its data area in the Unit
List.)

Chain. To conduct chain column movement, 

1. Select the hex occupied by the “leading” unit.

2. After making sure no unit in that hex is Selected, hold down the Ctrl key and right-click in
the adjacent hex you wish that unit to move to. 

As it moves, the entire group will follow, with each unit in turn entering the hex just vacated by the
one in front of it. Note, however, that chain column movement will not work in a hex that has two or
more friendly units adjacent to it if those units are in different hexes and are adjacent to each other, or if
the “leading” unit is adjacent to two or more units in different hexes.

Column movement can also be conducted using Auto Movement (see above). To do so, hold
down both the Ctrl and Alt keys when you right-click in the hex you wish the “leading” unit to move
to.

COMBAT
There are two basic types of combat in the game: Ranged Fire and Melee. A regiment or battery that
takes casualties due to combat has its manpower (“S#” in the Unit List) lowered by 25 men or more;
an artillery unit may lose one or more guns (each S# = one gun). If a unit’s S# is reduced to zero in
this manner the unit is eliminated. See below for more details. The combat results tables for both
types of combat appear in the Parameter Data, which can be found by Selecting Scenario Notes in the
Help menu. IMPORTANT: Each regiment and battery has a Field of Fire that it cannot attack outside
of; see 6.7.

Ranged Fire
Ranged Fire is simply one regiment or battery shooting at another at a range of one or more hexes.
You can conduct Ranged Fire during the Offensive Fire Phase of your Player Turn and the Defensive
Fire Phase of your opponent’s Player Turn. During that fire phase, each of your units able to fire can
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make one Ranged-Fire attack, and that attack can be made vs. only one enemy unit. Routed units, and
those that are out of ammunition and/or facing “away from” (see 6.7) the enemy cannot attack. Ar-
tillery that unlimbered or moved (even just to change Facing) in the Movement Phase cannot fire in
the ensuing Offensive Fire Phase. See also 6.7 COMBAT, Ranged Fire and Resolving Ranged-Fire on
p.48.

You can perform a Ranged Fire attack in three different ways:

Right-click Target Hex. To use Ranged Fire, Select the regiment or battery that will fire, then right-
click in the target hex.

Drag-and-Drop. Another way to conduct Ranged Fire is to use “drag-and-drop”. Select the unit that
will fire, then place the cursor on that units hex, press and hold down the left mouse button, move the
cursor to the target hex, and then release the mouse button.

Auto Fire. A third method is Auto Fire. Hold down the Alt key and right-click in the target hex. Adi-
alog box will appear, listing the name and location of one your units that is eligible to fire at that hex.
If you Select OK in the box, that unit will fire.

Melee
A Melee occurs when one side attempts to advance one or more of its infantry or cavalry regiments
into an adjacent, enemy-occupied hex during the Melee Phase. Routed/Disrupted units, artillery, sup-
ply wagons, and regiments facing “away from” (see 6.7) the adjacent enemy cannot advance into a
Melee. Only mounted cavalry (and one or more accompanying mounted leaders) can advance into a
hex that contains mounted cavalry. The exception being that when a cavalry unit is Isolated it can be
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meleed by non-mounted units. A unit can attack in Melee, and a hex can be assaulted, only once per
Melee Phase. If all defending units are eliminated or forced to retreat, the attacking unit(s) will auto-
matically occupy the defending hex.

Drag-and-Drop. One easy way to conduct Melees is to use “drag-and-drop”. To do this, 

1. Select all the units in a hex which you wish to attack with.

2. Then place the cursor on that hex, press and hold down the left mouse button, move the cursor
to the adjacent hex you wish to attack, and then release the mouse button.

3. Repeat this for each hex that contains one or more units you wish to add to that Melee,
then resolve the attack by Selecting the “resolve Melee” Toolbox button. 

For more details, see 6.7 COMBAT, Melee and Resolving Melee on p.50.

LEADERS
Each brigade, division, corps and
army has its own historical
leader. A leader provides no ben-

efit to movement or Ranged-Fire attacks,
but can aid in Melee attack/defense and
lower the chance that a unit he is stacked
with will Rout. Most importantly, a
leader can use his Command and Lead-
ership ratings to aid Disrupted and Rout-
ed units under his command in their at-
tempts to Rally and Reform. The proper
positioning of brigade and division lead-
ers is vital to maintaining the cohesion of
one’s forces. For more details see 4.4
THE UNIT LIST, 5.2 LEADERS and 6.8
RALLY.

QUALITY
Each regiment and battery has a Quality rating (“Q” in the Unit List) of “A” (best), “B”, “C”, “D”,
“E” or “F”(worst). The program uses these rating at various times to make die rolls (“A” = “6”; “F” =
“1”) to determine if the unit will Disrupt, Rout or Rally. See Morale Checks on p.51 and Disruption
& Rout on p.52.

DISRUPTION
A regiment or battery can become Disrupted when it takes casualties, and automatically be-
comes Disrupted whenever it is involved in a Melee (some units will also become Disrupted

upon entering certain types of terrain; see 6.1 TERRAIN). Units moving in line formation at night auto-
matically become Disrupted. Disrupted status is indicated by a “D” icon in the Unit List. For more de-
tails see Disruption & Rout on p.52.
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ROUT
A regiment or battery can become Routed when it takes casualties, loses a Melee, or
another friendly unit in a nearby hex Routs. Routed status is indicated by an “R”
icon in the Unit List and by a unit icon containing one or more running figures. Vari-
ous conditions can affect the chance that a unit will become Routed; see Disruption
& Rout on p.52.

RALLY
At the beginning of each Player Turn, the program attempts to Rally (i.e., bring back to Good Order)
each of that side’s Disrupted/Routed units. The results are displayed in the Command Report dialog.
For more details see 6.8 RALLY.

FATIGUE
Each regiment and battery has a Fatigue level (“FA” in the Unit List) of between “0” and “9”. Fatigue
can occur/increase due to combat. The higher a unit’s Fatigue, the weaker it is in Melee, the less effec-
tive it conducts Ranged Fire, and the more likely it will be to Rout when it suffers casualties. For
more details see 4.4 THE UNIT LIST and 6.9 FATIGUE.

SUPPLY
Whenever a regiment makes a Ranged-Fire attack, the program checks to see
if it has depleted its ammunition supply. (The probability is 1-in-24.) If it has,

a “hollow bullet” (indicating no ammo) or “half-hollow bullet” (indicating low ammo) icon
appears in its icon section in the Unit List. A regiment suffering from low/no ammo has cer-
tain restrictions placed on its Ranged-Fire capabilities, but can be resupplied by a friendly supply
wagon; see 5.4 AMMO & SUPPLY WAGONS.

Artillery  Ammo. There is a separate ammo supply limit for artillery; see Artillery Ammo on
p.35.
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STACKING
Stacking is limited to a total of eight regiment, battery and/or supply
wagon units per hex. No more than 1000 men, or 20 cannons, may
occupy a hex (displayed as “S#” in the Unit List). Stacking limits
apply per side in Melee. Regardless of other stacking rules, only one

supply wagon may occupy a hex.

Infantry, Cavalry & Artillery: 1,000 (S# total) in no more than 8 units. For stacking purposes, one
gun equals 50 men.

Leaders: No stacking limit.

Supply Wagons: Regardless of other stacking rules, only one supply wagon may occupy a hex.

You can move a unit from the bottom to the top of a stack in the Hot Spot hex by Selecting To
Top of Stack in the Units menu (if playing on the 2D map, this can sometimes be helpful as you can
bring a specific unit to the top of a stack so it is displayed). That menu also contains a To Bottom of
Stack command. When using either the 2D Normal View or Zoom-Out map you can display all
leaders on the top of their stacks by Selecting Leaders on Top in the Display menu.

TERRAIN
Terrain can affect movement, LOS and
Ranged-Fire combat. Breastworks and
embankments can also affect Melee and
Ranged-Fire combat. These effects are
listed in 6.1 TERRAIN, and in Parameter
Data (which can be found by Selecting
Scenario Notes in the Help menu).
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3.1  THE MENU SCREEN
When you launch BATTLEGROUND: BULL RUN, the Menu Screen appears after the introduction.
This screen presents you with five choices:

• Start New Scenario: Select this to proceed to the Scenario Selection Screen to start a new scenario.

• Resume Saved Game: Select this if you wish to resume playing a non-modem game you had
saved and quit previously.

• Start Game as Modem Host: Select this to become (or resume being) the Host for a modem-play
or an Internet game.

• Start Game as Modem Caller: Select this to become (or resume being) the Caller for a modem-
play or an Internet game.

• Special Options: Select this to start (or resume) a Play-By-E-Mail (PBEM) game or a Two-Player
Hot-Seat game.

Choosing a Scenario
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3.2  THE SCENARIO SELECTION SCREEN
This screen lets you pick a new scenario to play. First, Select the name of a scenario. Once you’ve decid-
ed on a scenario, make sure its name is highlighted, and Select the Play button. Adialog box will then ap-
pear, giving you the choice of what type of A/I you wish to use for each side. (For your choices, see 3.3
THE TYPES OF A/I.) When you Select OK, the scenario will begin.

The Previous button takes you back to the Menu Screen, and the Exit button takes you back to
Windows®.

3.3 THE TYPES OF A/I
The type of A/I you choose will deter-
mine the amount of control the game’s
“Artificial Intelligence” exerts on play.
When A/I is being used, the program will
make some or all of the decisions for a
particular side and automatically conduct
all appropriate actions, such as firing and
moving. The A/I can be used in four
modes: Manual, Commander Control,
Automatic, and Automatic with Fog-of-
War. Any one mode can be applied to
each side.

Manual equals “no A/I”. Select this for a side if you want to make all the decisions for that
side, including conducting all moves and attacks for it. This is the default mode for both sides.

If you Select Commander Control for a side, you’ll be able to give orders (attack, defend,
etc.) to the various leaders you choose to command on that side, while letting the program automati-
cally handle all other actions for the side, such as moving and firing.
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If you Select Automatic for a side, the program will handle all the decisions and actions for that
side.

If you Select Automatic with FOW (Fog-of-War) for a side, the program will handle all the de-
cisions and actions for that side, and Fog of War will be in effect. This mode is most appropriate
when you want to control one side and have the program control the other.

The Set Advantage bar at the bottom of the A/I Selection screen allows you to balance play be-
tween two players of unequal skill or to balance play against the A/I. To set an Advantage, hold down
the left mouse button over the needle and move it to the left or right (the keyboard’s arrow keys can
also be used to adjust the advantage). Advantage values can range from 0 to 100 for either side. De-
pending on the value you set, the side with the advantage will inflict higher than normal combat loss-
es on the other side, and suffer lower than normal combat losses themselves. Advantage must be set
before play begins in E-Mail or Modem Play games. Otherwise, the Advantage can be adjusted at
any time during the game.

If you Select Rules you will see a menu of rules that can be enabled or disabled to enhance
gameplay for advanced players. See 6.11 OPTIONAL RULES for more details.

To use the A/I during play, see 6.3 USING THE A/I.

3.4  RESUMING A SAVED GAME
To open a previously saved (non-Modem, non-Play-By-E-mail, non-Two-Player-Hot-Seat) game, Se-
lect Resume Saved Game in the Menu Screen. A dialog box will appear, in which you must Select
the saved-game file you want. At this point, select the module your game is saved in. All the games
currently saved within that module will appear in the “Select a Battle” window. Highlight the name of
the saved game you wish to resume, then Select OK.

For resuming a saved Modem-play game see page 59; for resuming a saved Play-By-E-mail game
see page 60.

If the game had been saved and exited during a phase that was controlled by the A/I, you may
have to Select the Activate A/I menu command (or its corresponding Toolbox button) to restart it.
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4.1  THE TITLE BAR
This appears at the very top of the screen, and displays the name of the scenario currently being
played.

4.2  THE MENU BAR
This appears directly below the Title Bar, and displays the names of the various pop-down menus.
These menus and their commands are explained below.

File Menu: Use this menu to load a previously saved game, or to save and/or exit a
game.

Select New to start a new scenario. (Do not change directories in the dialog box that
appears.) Anew scenario has the extension .scn.

Select Open to resume a previously saved game. A previously saved game file has
the extension .btl.

Select Save to save the game you are playing.

Select Save As to save a game under a file name other than the one currently being
used for it.

Select Snapshot to save a copy of the portion of the map (including the position of all unhidden units)
that is currently in memory as a bitmap (.bmp) file. (See 4.8 SNAPSHOTS.)

Select Replay to view a recorded battle. To halt the replay, press the Esc key

Select Exit to quit the scenario and return to the Menu Screen. If the current game has changed since the
last time it was saved, a dialog will appear giving the option to save it before exiting.
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Phase Menu: Use this menu when you want to proceed from one phase to the
next.

Select Next to advance the game to the next phase.

Units Menu: Use this menu to change the position of friendly units,
and to initiate artillery attacks. Most changes can occur only during
the Movement Phase, and are subject to limitations as a result of the
program rules and movement allowances.

Select To Top Of Stack to move a Selected unit to the top of its
stack.

Select To Bottom of Stack to move a Selected unit to the bottom of
its stack.

Select Turn Clockwise to change the Facing of a Selected unit one
hexside in a clockwise direction.

Select Turn Counterclockwise to change the Facing of a Selected
unit one hexside in a counterclockwise direction.

Select About Face to change the Facing of a Selected unit 180º.

Select Change Formation to change the Formation of a Selected unit.

Select Recrew Battery to provide a new crew for an abandoned friendly artillery battery; see 5.3 AR-
TILLERY.

Select Remove From Map to voluntarily remove a unit from the map. Removal can occur only dur-
ing a friendly Movement Phase, and the unit must be in a map-edge hex. 

To remove a unit from the map,

1. Select the unit.

2. Select the Remove from Map command. Removed units do not count towards victory condi-
tions.

Select Artillery Dialog to make attacks with artillery units during the Offensive or Defensive Fire
Phase.

Select Undo Last Movement to cancel the entire movement of the most-recently-moved still-Select-
ed friendly unit, so you can instead move it in a different way (or not at all). This command is dis-
abled during Modem play, Play By E-mail, and whenever Fog of War is in effect. This command
cannot be used to cancel the move of a unit that has just captured a battery or leader by entering its
hex in the Movement Phase.

Melee Menu: Use this menu to conduct Melees.

Select Clear Melee to cancel a melee without resolving it.

Select Add to Melee (after right-clicking in a hex to mark it as a Melee hex) to
designate the currently Selected unit(s) as participating in the Melee.

Select Resolve Melee to resolve a Melee in the Hot Spot hex.

Select Show Differential to review the current Strength difference between the two sides in the
Melee in the Hot Spot hex.
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Reinforce Menu: Use this menu to check on the availability of reinforcements.

Select Scheduled to display the reinforcements that are scheduled to arrive during
the current scenario, as well as the per-turn arrival probability for each unit. Double
clicking on the selection will bring up a Dialog Box listing the individual units in

the reinforcement. If Fog of War is in effect for one or both sides, only the reinforcements for the side
currently having its Player Turn will be displayed; otherwise, all reinforcements will appear.
Select Arrived during a friendly Movement Phase to display the reinforcements that are currently
available to be placed on the map.
Select Releases for a display listing the release times of Fixed units; Choosing.an entry in the Release
Dialog causes that organization to become highlighted on the screen. Double clicking or selecting OK
causes the release dialog to be dismissed and the organization to remain highlighted. Selecting Cancel
causes the organization to become unhighlighted.

Status Menu: Use this menu to display current strength, objective, and vic-
tory information.
Select Strength to see the current “manpower” strength of each regiment
and higher organization. If an organization is not all in Good Order, the per-
centage shown is the percentage of the organization that is in Good Order (a
“Good Order” unit is neither Disrupted nor Routed). If Fog of War is in ef-

fect for a side, its strengths will appear only during its own Player Turn.
Select Objectives to see the number, value and hex location of each Objective. Selecting the Objec-
tive-hex lines in the dialog box will put the Hot Spot in (and scroll the map to) that hex.
Select Leader Casualties for a listing of leaders killed (K), captured (C) or wounded (W) during the
currently played scenario. Selecting the leader will scroll the map to the hex where the leader became
a casualty.
Select Victory to see the current level of victory and related items.

The Game Interface

Battleground: Bull Run18



Display Menu: Use this menu to control how information is
displayed on the map.
Select Units Off to toggle (off or on) the on-map display of all
units and markers. This option is provided to hide them in
order to see the underlying map terrain better.
Select Unit Bases Off to toggle (off or on) the bases of the unit
icons on the 3D (Battleview™) map.
Select Leaders on Top to control the on-map display of leaders
on the 2D maps. When this command has a check mark next to
it, leaders appear above all other units in their hex.
Select Objectives to toggle (off or on) the display of Objectives
on the map. When this command has a check mark next to it,
each Objective hex will be marked with the flag of the side that
controls it.
Select Locations to help you find a named location on the map.
When you Select one of those listed, the map will scroll to that
hex and put the Hot Spot in it.
Select Visible Hexes to toggle (off or on) a display of which
hexes are in the LOS of the current Hot Spot hex. A red “X” in
a hex indicates no LOS. When on, this command has a check
mark next to it.
Select Full Screen Map to toggle (off or on) the Unit List and
Terrain Info Box. When this command has a check mark next

to it, these items are hidden. Units can still be Selected when the Unit List is hidden; see THE POP-UP

SELECTION DIALOG on p.27.
Select Show Organization to see which units belong to which organizations. When you Select an or-
ganization name in the Organization Dialog, each of that organization’s component units becomes
highlighted on the map. If Fog of War is in effect for one or both sides, only the organizations for the
side currently having its Player Turn will be displayed. An organization name printed in light gray in-
dicates that all of its units are currently off-map (i.e., are reinforcements yet to arrive).

Select Find Leader or Units to display a dialog box that will let you find a specific unit or leader on
the map. After Selecting this command, 

1. Acursor will appear in the white box labeled “Enter search”.

2. Type in the name of the leader or unit (being sure to spell and capitalize it the same way it ap-
pears in the game).

3. Select Search. 

All occurrences of that name in the Order of Battle will appear in the larger white box. Select the one
you’re looking for, then Select OK or double click on the unit and the map will scroll to that unit’s po-
sition.

Select Jump Window to display a miniature of the map. When you Select any spot in the minia-
ture version, the game map will automatically scroll to the corresponding spot.

Select Highlight to get submenu of the following options:

Fixed Units toggles (off or on) a highlight around all Fixed units.

Spotted Units toggles (off or on) a highlight around all units that have a LOS to (and thus are in the
LOS of) at least one enemy unit.
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Low on or Out of Ammo, or Uncrewed toggles (off or on) a highlight around all units  low on or
out of ammunition and/or have no crew (the latter applies only to artillery batteries).

Fired/Fought Units toggles (off or on) a highlight around all units that have either fired at an enemy
unit or fought in a Melee during the current phase.

Moved Units toggles (off or on) a highlight around all units that have moved during the current
phase.

Disrupted Units toggles (off or on) a highlight around all units that are Disrupted. Leaders that are
highlighted when this option is on (or when the “D” toolbox button is pressed) are the ones that
failed their last command check (see Command Radius/Rating, p.53).

Detached Units toggles (off or on) a highlight around all units that are Detached.

High Fatigue Units toggles (off or on) a highlight around all units that have a Fatigue Level of 7 or
higher.

Isolated Units toggles (off or on) a highlight around all units that are Isolated.

Non Full Strength Units toggles (off or on) a highlight around all units that are not at Full Strength.

Supply Wagons toggles (off or on) a highlight around all Supply Wagons.

Organization toggles (off or on) a highlight around all units that are part of the same organization as
the first Selected unit, or are subordinate to the Selected leader, in the Unit List.

Select 2D Normal View to change the map to its 2D version.

Select 2D Zoom-Out View to change the map to a smaller, low resolution 2D version that enables
more of it to be seen.

Select 3D Normal View to change the map to its full-size 3D (Battleview™) mode.

Select 3D Zoom-Out View to change the map to Battleview™ mode but with the hexes at half their
normal size.

Select Rotate Toolbox to toggle the Toolbox between its vertical and horizontal orientation.

A/I Menu: Use this menu to control the “Artificial Intelligence”
capabilities of the program.

Select [Manual] (i.e., no A/I) for a side if you want to make all
the decisions for that side, including conducting all moves and at-
tacks for it. This is the default mode for both sides.

Select [Commander Control] for a side if you’d like to choose
certain leaders to command yourself (i.e., to give orders to),
while letting the program automatically take care of all other de-
cisions and actions for that side.

Select [Automatic] for a side if you want the program to handle
all the decisions and actions for that side.

Select [Automatic with Fog-of-War] for a side if you want the program to handle all the decisions

Note: The menu options beginning with Fixed Units and ending with Organization are mutually
exclusive; i.e., Selecting any one of them will toggle-off any of the others that had been previously
Selected. During the Melee Phase, each unit that is designated to engage in Melee becomes high-
lighted if no other highlight is currently Selected.

The Game Interface

Battleground: Bull Run20



and actions, and have Fog of War in effect, for that side.

Select Set Advantage to balance play between two players of unequal skill or to balance A/I play.
Advantage values can range from 0 to 100 for either side. Depending on the value, the side with the
advantage will inflict higher than normal combat losses on the other side, and suffer lower than nor-
mal combat losses themselves. Advantage must be set before play begins in E-Mail or Modem Play
games. Otherwise, the Advantage can be adjusted at anytime during the game.

Select Activate A/I to restart the A/I after you have canceled it, or if you started the phase not using
A/I but wish to activate it for the remainder of the phase.

Special Menu: This menu provides the special options necessary to play
a scenario via modem, null-modem, PBEM, Two-Player Hot-Seat, or
even to record a game in progress.

Select Modem Host before you start a modem game if you wish to be
in charge of opening and saving the scenario, and to configure your
modem for play. The Host player can also use this command to close the
playing session.

Select Modem Caller before starting a modem game if you wish to let
the other player be responsible for opening and saving the scenario, and
to configure your modem for play. As the Caller, you have the option of
specifying an encryption key. The Caller can also use this command to
close the playing session.

Select Play by E-Mail to begin an E-Mail game. (See 7.3 PLAY BY E-MAIL for more information.)

Select Two-Player Hot-Seat to play a scenario with another human opponent on your computer with
Fog of War automatically in effect. After this is invoked from the Special menu, you must then select
New (or Open to resume a saved game) from the File menu. The extension .btt is used to denote a
Two-Player Hot-Seat saved-game file.

Select Record Battle to toggle (on or off) the option that allows you to save a record of the game you
are currently playing. 

Select Null Modem if you wish to start a game using a null-modem cable.

Select Internet Connection if you wish to start a game using a TCP/IP Connection. 

Select New Encryption Key in a modem game if you are the Caller and wish to specify a
new encryption key. As the Caller you must ensure that the same encryption key is used when
re-opening a saved-game file as was used when the file was saved previously. The extension
.btx is used to denote an encrypted saved-game file. For more on encryption keys, see p.56.

Select Resync With Remote in a modem game if the two sides get out of sync (e.g., due to a bad
data transmission). Using this command re-transmits the entire scenario to the other player’s comput-
er. The Resync option should rarely be needed, as error checking is incorporated into the modem pro-
tocol used by the program. Before using it, check with the other player to ensure that he agrees a sce-
nario resync is necessary. Alternatively, the Host can save the current scenario and open it again.

Select Restart Replay to restart the replay of a previously halted recorded battle file. 

Select Communication Dialog in a modem game to display the “chat window” if you had closed it
previously. 
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Options Menu: Use this menu to set the default for certain options associat-
ed with the main program. A check mark next to a command in this menu
means that it is “on.”

Select Introduction to toggle (off or on) the introductory material that
plays when you launch the game.

The Prompt For Scenario feature is only usable if you selected a “Custom”
Install during set-up and chose the “Map Icon” option. With this feature tog-
gled on (i.e., with a check next to it), you will be prompted for a new sce-
nario when you enter the game directly via a “map icon” (instead of using
the “Battleground Bull Run” icon). 

Select Beep on Error to toggle (off or on) the option that causes a beep
when you make an error.

Select Blink Hot Spot to toggle (off or on) the option that causes the Hot
Spot to blink. [Exception: the Hot Spot never blinks on the 3D maps.]

Select Smooth Scroll to toggle (off or on) the option that causes the map to
scroll incrementally to a new Hot Spot. When this command has no check mark next to it, the map
redraws directly at the new Hot Spot hex without scrolling through the intervening hexes.

Select Sound Effects to toggle (off or on) the playing of sound effects.

Select Background Music to toggle (off or on) background music.

Select Video Effects to toggle (off or on) the playing of video clips.

Select Graphical Unit Icons to toggle the display of unit icons between graphical and military-type
schematic versions.

Select Leader Faces to toggle between a portrait-type and a graphical icon for each leader when
using the 2D Normal View map (only). Note: Graphical Unit Icons (from the Options menu) must be
“on” for the leaders’faces to show up. 

Select Hex Outlines to hide or display the map’s hex outlines. When the hex outlines are visible, this
command has a check mark next to it.

Select 3D Dialogs to toggle the appearance of the program dialogs between an enhanced 3D version
and the standard Windows® version.

Select Dialog Help Buttons to hide or display the Help buttons in the program dialogs.

Select Auto Save to have the program save the game automatically at the end of each phase [Excep-
tion: it will not save a phase that was conducted under Automatic A/I (with or without Fog of War)
control].

Select Graphics Buffering to enable a graphics mode which will reduce flicker in the 3D views.
However, may cause the game to run slower on certain systems.

Select Initial View to define the initial view of the map when the main program is started. The views
may be set to any of the standard views, or to default to the last one used while playing the game.

Select Optional Rules to display a menu of game options that in effect for the current scenario. These
rules must be set at the start of a scenario and cannot be changed during gameplay. The game will de-
fault to use the options marked upon the start of a new scenario.
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Help Menu: Use this menu to get information about how to use the
BATTLEGROUND: BULL RUN program, about the battle being
fought, and about the program itself.

Select General Help to open the BATTLEGROUND: BULL RUN
General Help file.

Select Scenario Notes to find miscellaneous information on the two armies, their orders of battle, and
the data used internally in the game (such as the various combat tables, the height of obstacles, the
movement costs and defensive modifiers of the various terrain types, etc.).

Select About Battleground Bull Run to display a dialog containing version and copyright informa-
tion about BATTLEGROUND: BULL RUN.
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4.3 THE MAP
The map can be viewed in five different scales. 

Jump Map. The smallest map is the Jump Window, which displays the entire map in play (for
details on using the Jump Window, see SCROLLING, p.25). On this map, red and blue dots indicate
the positions of Confederate and Union units (respectively). The jump map allows you to see, at a
glance, the entire disposition of your forces, as well as all known enemy units. Clicking anywhere
on the jump map will take you to that location.

2D Zoom-Out View. The smallest playable size is the 2D Zoom-Out map, which is displayed by Se-
lecting 2D Zoom-Out View in the Display menu. This is best used for a quick, overall view. Units on
this map view cannot be distinguished from each other as easily as on the other maps, but their posi-
tions relative to the opponent’s units are readily apparent over a wider area.

2D Normal View. The next scale is called the 2D Normal View, and is displayed by Selecting 2D
Normal View in the Display menu (or, if the map is currently in the 2D Zoom-Out mode, by Select-
ing the “Zoom Map” button in the Toolbox). This presents the terrain in more detail than the 2D
Zoom-Out map while showing a larger area than the 3D maps. You can choose to display units on the
2D Normal View map with either graphical icons or military symbols (see 5.0 THE UNIT TYPES).

3D Zoom-Out. The 3D Zoom-Out view displays the Battleview™ map at half of its normal size,

3D Zoom-Out 3D Zoom-In

2D Zoom-Out 2D Zoom-In

Jump Map (3D)
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thus allowing twice as much of it to be seen at a time. This is the default map when you start the
game.

3D Normal View. The ultimate map view is the 3D Normal View mode, which is displayed by Se-
lecting 3D Normal View in the Display menu (or, if the map is currently in the 3D Zoom-Out mode,
by Selecting the “Zoom Map” button in the Toolbox). This presents the Battleview™—a high-resolu-
tion map in 3D-type isometric perspective, presenting much more detail on the screen. In this view,
units are shown as “miniatures” with individual positions within their hex.

Scrolling
In most cases the map is too large to fit completely onto the screen, even in those scenarios where
only a portion of the overall map is used. Therefore, several different ways to scroll it are provided.
You can use the standard Windows® scroll bars, the arrow keys on your keyboard, or the Jump Win-
dow.

To use the Jump Window, Select its button in the Toolbox or the Jump Window command
in the Display menu. This will display a miniature of the map being used (along with an indi-
cation of where each side’s units are). Then Select the desired spot in the jump map, and the

game map will automatically scroll to the corresponding point.

Place Names
Press the Shift key to display the names of vari-
ous roads, farms and other geographical features.
These names are given for historical reference
only.

Hex Coordinates
Each hex on the map has a unique set of coordinates, given in the form “#, #”. The
number on the left represents the vertical row of hexes (beginning with “0” for the

left-most column of hexes on the map), while the number on the right represents the horizontal row
(beginning with “0” for the topmost row). 

The coordinates of the Hot Spot hex are displayed at the far right end of the Status Bar (see
4.6).
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4.4  THE UNIT LIST
The Unit List is the portion of the screen display immediately below the map. It contains a representa-
tive drawing of each unit that occupies the current Hot Spot hex, plus that unit’s name and pertinent
game data. A horse-head icon in the upper right-hand corner of a battery’s Unit List picture signifies
that battery as horse artillery. 

To Select a unit in the Unit List, left-click anywhere in its data area. To view the organizational in-
formation for a unit, right-click on its name in the Unit List and hold down the mouse button. 

When there are more non-leader units in a hex than can be displayed in the Unit List, the
arrow buttons in the lower right corner of the screen turn bright red (become highlighted)

and can be used to scroll the Unit List.

The Unit List can be hidden by Selecting either Full Screen Map in the Display menu or its
equivalent Toolbox button.

Leaders in the Unit List
The following explains the abbreviations and numbers displayed for leaders in the Unit List:

C (Command): The leader’s Command Rating, given in the form “A” (best), “B”, “C”, “D”, “E”
or “F” (worst). This rating is used by the program to determine the leader’s ability to stay “in com-
mand”, thereby aiding the Rally of his Disrupted units. When the leaders command rating is dis-
played in red, it indicates that the leader has failed the command test for that current turn.See COM-
MAND RADIUS/RATING on p.54.

An icon “behind” the number when the Leader is Selected indicates that he is currently De-
tached.

In addition, a leader’s Command Rating is reduced by 1 during night turns.

L (Leadership): The leader’s Leadership Rating, given in the form “A” (best), “B”, “C”, “D”, “E” or
“F” (worst). This rating is used by the program to let the leader aid in the Rally of a Routed unit he is
stacked with; see 6.8 RALLY.

M (Movement): The leader’s current Movement Allowance. This number will decrease as he moves. 

An icon “behind” the number when the Leader is Selected indicates that he is currently
mounted.

A star appearing in the lower right-hand corner of a leader’s Unit-List portrait means that he has

Command Rating
Leadership Rating
Movement Allowance
Leader’s Name (right-click for organization info)
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been “promoted” to the command of a higher organization due to the elimination or promotion of that
organization’s original leader.

Combat Units & Supply Wagons in the Unit List
The following explains the abbreviations and numbers displayed for combat units and supply wagons
in the Unit List:

S (Strength): The unit’s current basic attack (and, if a regiment, defense during Melee) strength. This
number represents the actual number of men in the unit (rounded to the nearest 25). This number is
also used to determine stacking limits; see STACKING on p.11. If the S# appears on a red background
the unit is Isolated; refer to the Appendix (p.63) for more details on being Isolated. To display a unit’s
original strength, right click on the unit in the Unit List.

RG (Range): The maximum range at which the unit can make a Ranged-Fire attack. A unit with a
range of  “–” cannot attack in any way.

MV (Movement): The unit’s current Movement Allowance. This number will decrease as the unit
moves or changes Facing/Formation.

QL (Quality): The unit’s Quality, given in the form “A” (best), “B”, “C”, “D”, “E” or “F” (worst).
This number does not change during play.

FA(Fatigue): The unit’s current Fatigue level: “0”-“3” cause no adverse effect (these numbers appear
in green); “4”-“6” represent Low Fatigue (and appear in red-orange); “7”-“9” are High Fatigue (and
appear in dark red). See also 6.9 FATIGUE.

Unit-List Icons
One or more of the following icons will appear from time to time in the lower-center compartment of
a non-leader unit’s data area. These icons, as they appear from left to right on the screen, represent the
following:

Infantry/Cavalry Regiment. When the full-color bullet appears, the regiment is
eligible to attack. Once it has attacked, the bullet turns brown. A unit’s S# that is

printed in yellow indicates that the unit is not at full strength(Right click on the Unit List picture to
view the full strength value. If the unit becomes low on ammo, the bullet will change to “half hollow”
(i.e., half color and half outline). If the unit becomes out of ammo, the bullet will change to complete-
ly hollow (i.e., outline only).

Artillery Battery. When the full-color cannonball appears, the battery is eli-
gible to attack. Once it has attacked, the cannonball turns brown. If the bat-

tery is low on ammo due to Isolation the cannonball will change to “half hollow” (i.e., half color and
half outline). If the battery is out of ammo, the cannonball is hollow (i.e., an outline). If the battery is
uncrewed, a red “X” is drawn through the cannonball, and an UNCREWED banner will appear in
the unit list.

S (Strength)

RG (Range)

MV (Movement)

QL (Quality rating)

FA (Fatigue level)

Unit List Icons

Unit Name (right-click for organization info)
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The letter indicates the type of weapon the unit is equipped with:

When the wheel appears, the unit is eligible to move. Once it begins to move, the wheel turns
brown. When it has used all of its movement allowance, the wheel disappears.

When the “F” on a red background appears, the unit is Fixed, meaning that it cannot leave its
hex. For more information, see p.46.

These icons show the unit’s present Facing (as indicated by the direction the red arrow is
pointing) and Formation. Depending on the unit type, the two parallel yellow lines indicate

that it is either in line, dismounted or unlimbered (as shown by the icon illustration on the left) or in col-
umn, mounted or limbered (as shown by the illustration on the right).

When the pick-and-shovel appears, the unit is constructing breastworks.

When the “D” appears, the unit is Disrupted.

When the “R” appears, the unit is Routed.

When the full-color binoculars appear, the unit is currently in the LOS of (and thus also
has a LOS to) at least one enemy unit. If the only enemy unit having a LOS to the unit

when Fog of War is in effect is an enemy supply wagon, the binoculars are brown, indicating that the
identity of your unit is not known to the enemy .

The Pop-Up Selection Dialog
The Pop-Up Selection Dialog allows you to Se-
lect any unit(s) in the Hot Spot hex even if the
Unit List is hidden. To display this dialog, left-
click on a map hex with a unit you wish to Se-
lect, then simply press the spacebar. You can
then Select a single unit by left-clicking on its
name in the dialog, or Select multiple units by

holding down the Shift or Ctrl key when you left-click. Double-clicking on a name is the same as
pressing Enter, which is the same as Selecting OK. The information at the beginning of each unit
name is that unit’s S# and weapon type. Disrupted and Routed units will have an icon to indicate
their current state.
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B: Breech-loading rifles

C: Carbines

H: 12-pounder howitzers

L: 6-pounder smoothbore cannons

M: Smoothbore muskets

N: 12-pounder Napoleon cannons

P: Pistols

R: Rifled muskets

S: Spencer repeating rifles

T: 10-pounder Parrott or 3-inch Rodman
cannons

Weapon Types



The Terrain Info Box
The Terrain Info Box appears in the lower-left-hand corner of the screen, pre-
senting information about the current Hot Spot hex. It displays a digitized
photo (most of which were taken from actual sites around the Bull Run battle-
field) of the type of terrain in the hex (clear, orchard, forest, etc.), then lists that
terrain type by name and gives its Ranged-Fire combat modifier, its elevation
in feet, and its Objective value.

The bottom line of the Terrain Info Box shows the current artillery
ammunition supply for each side (in the form “#/#”, with the Union total on the left and the
Confederate total on the right). See Artillery Ammo on p.35.

Finding Hexside Terrain Features Using the Terrain Info Box
In BATTLEGROUND: BULL RUN, there are a number of terrain features which exist along or through
hexsides(e.g., roads and streams). To learn which of these features are present in or alongside the current
Hot Spot hex, click anywhere on the Terrain Info Box. The information in the Terrain Info Box will dis-
appear and the name(s) of the extra terrain feature(s) will appear. 

Selecting a Unit
To Select a unit in the Unit List, left-click anywhere on its area in the List. You can quickly Select all
the units shown in the Unit List by double-clicking with the left mouse button in the Hot Spot hex.

Right or left click anywhere in the Terrain Info Box for a display of the hexside
terrain features. These terrain features are arranged (roughly) in the locations
pertaining to the hexsides they run along or through. 

For example, in the illustration at left, a stream runs along the “lower” hexside
of the Selected hex, and a road runs through the hex, crossing the lower left
and upper right hexsides.
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4.5  THE TOOLBOX
The Toolbox enables you to conduct certain actions without having to use the pop-down menus. Se-
lecting a Toolbox button initiates the associated command. These commands are:
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Advance the game to the next phase.

Change the screen display between the 2D Normal View and 2D Zoom Out, or 3D Normal View and
3D Zoom Out, mode.

Change the Facing of the Selected unit(s) one hexside in a counterclockwise direction.

Change the Facing of the Selected unit(s) one hexside in a clockwise direction.

Change the Facing of the Selected unit(s) by 180º.

Change the Formation of the Selected infantry unit from column to line (and back), limber/unlimber
an artillery unit, or mount/dismount a cavalry regiment or leader.

Toggle (off or on) the on-map display of all units.

Toggle (off or on) the bases of all unit icons on the 3D map.

Make the Artillery Dialog appear.

Resolve the Melee in the Hot Spot hex.

Toggle (on or off) a highlight around all infantry/cavalry units suffering from low/no ammo or un-
crewed artillery units.

Toggle (on or off) a highlight around all units that have a LOS to (and thus are in the LOS of) at least
one enemy unit.

Toggle (on or off) a highlight around all units that have moved during the current phase.

Toggle (on or off) a highlight around all units that have either fired at an enemy unit or fought in a
Melee during the current phase.

Toggle (on or off) a highlight around all units that are Disrupted.

Toggle (on or off) a highlight around all units that are part of the same organization as the first Selected
unit in the Unit List.

Hide (or display) the Unit List and Terrain Info Box.

Toggle (on or off) a display of which hexes are in the LOS of the current Hot Spot hex. An “X” in a
hex indicates no LOS.

Display (or hide) the flag of the controlling side in each Objective hex.

Display the Jump Window. Select any spot on the jump map, and the game map will scroll to the cor-
responding spot.

Cycle the Hot Spot to another unit that has yet to (be designated to) perform an action pertinent to the
current phase.

Activate the A/I (after you have halted it, or if you started the phase not using A/I but wish to activate it
for the remainder of the phase).



4.6  THE STATUS BAR
The Status Bar (see illustration above) appears at the very bottom of the screen. Its main functions are
to show the current time of day, the current phase, and the coordinates of the Hot Spot hex, and a set
of scroll arrows (if the current Hot Spot hex has more non leader units in it than can be displayed at
one time). It also displays various types of messages from time to time (e.g., to explain why the pro-
gram won’t let you perform an action). In addition, it gives a brief explanation of each menu com-
mand and Toolbox button when you place the cursor on that command or button and hold down the
left mouse button. 

4.7  SAVING A GAME
When you start a new scenario, use the Save command in the File menu to save it. A dialog will
appear so you can specify a name for the saved-game file. Alternatively, you can Select Auto
Save in the Options menu, in which case you’ll be prompted at the end of each phase to save the
game. Once you’ve saved the game this way, it will be saved again automatically by the Auto
Save function at the end of each subsequent phase [Exception: it will not save a phase that was
conducted under Automatic (with or without Fog of War) A/I control]. Should you wish to save
the game at some other point in a phase, you can do so via the Save command.

To save the game under a file name different than the one currently being used for it, Select Save
As in the File menu. This allows you to save the current state of a battle in another file without affect-
ing the file being used for the battle.

4.8  SNAPSHOTS
The Snapshot command in the File menu enables you to save, as a “bitmap” (.bmp) file, a picture of
the portion of the map (including the position of all unhidden units) that is currently in memory.  Adi-
alog box will appear so you can specify the name of the file. 

You can use the Paintbrush graphics program (supplied with Windows®; Paint in Win95®) to
open the file later. Refer to your Windows® manual for instructions for the Paint(brush) program. The
Paint(brush) program can also be used with your printer (black and white or color) to supply you with
a printout of the map. Paint(brush) will allow you to resize the map (as desired) before printing.
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The Unit Types

Infantry and cavalry regiments, artillery batteries, individual leaders and supply wagons are
represented in the game. All, aside from unlimbered artillery, have an inherent movement ca-
pability; and all, aside from leaders, limbered artillery and supply wagons, can make attacks.
(Infantry in column and mounted cavalry can only engage in Melee.) Most of their character-
istics are covered in 2.0 THE BASICS OF PLAY, but more details on the special capabilities of
leaders, artillery units and supply wagons are given in 5.2-5.4 below. To see the attributes of a
specific unit during play, Select its hex to put it in the Hot Spot and check its data in the Unit
List.

5.1  UNIT ICONS
Many different icons are used to represent the units in the game. Refer to the chart on page 33 for a
sample illustration of each type of unit.

Military Symbol Icon Colors
The color of each “military symbol” icon indicates a general category of unit types, as explained
below (note that these colors appear only on the 2D Normal View map):

5.0 THE UNIT TYPES

Light Green: Infantry

Yellow: Cavalry

Red: Artillery

Gold (Star): Leader
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Map Type:
2D 2D 2D 3D

zoom zoom-in zoom-in zoom-in &
out graphical mil. sym. zoom out Unit Type:

Infantry regiment in line

Infantry regiment in column

Routed Inf/Cav/Art unit

Cavalry regiment in line

Cavalry regiment in column

Unlimbered artillery battery

Limbered artillery battery

Dismounted leader

Mounted leader

Supply wagon
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5.2 LEADERS
For the basics, see LEADERS on p.10. One leader per side can aid in Melee (when stacked with a unit) by
increasing his side’s differential by one. A leader lowers the chance that a unit he is stacked with will
Rout by adding a –1 modifier to that unit’s Morale Check die roll, and can aid units under his command
in their attempts to Rally. See also 4.4 THE UNIT LIST and 6.8 RALLY.

Adismounted leader is treated as infantry in column, and a mounted leader is treated as mounted
cavalry, for movement-cost purposes. Leaders can mount and dismount their horses by simply Select-
ing a leader during the Movement Phase and clicking the Change Formation button in the Toolbox.

A leader can be attacked as an individual target only if no other unit (aside from one or more
other friendly leaders) is in his hex. Leaders do not become Disrupted or Routed.

A leader can be killed, wounded or captured. In each case he is eliminated and another leader is
promoted at the start of the next friendly Player Turn to take over his command. (A leader so “pro-
moted” has a gold star in the lower right-hand corner of his portrait in the Unit List.) A mounted
leader is more likely to be eliminated in this manner as one who is dismounted. A defending leader is
automatically captured if all other friendly units in his hex are eliminated during Melee. 

Night Turns. Aleader’s Command Rating (C) is reduced by 1 during night turns.

Command & Leadership
Each leader has both a Command and a Leadership rating, which affect his ability to influence cer-
tain actions of other units under his command; Army and Corps leaders have an unlimited Com-
mand Radius.  see 4.4 THE UNIT LIST. In addition, brigade and division leaders have a limited Com-
mand Radius; 

5.3  ARTILLERY
An artillery battery can have its “crew” killed in combat, leaving the guns abandoned and unus-
able. An uncrewed battery has a red X in the Unit List. To provide an uncrewed battery with a

new crew, a friendly Good Order regiment that has not moved during the current Player Turn must be
in the hex with it during a friendly Movement Phase, and both must be Selected; then Select Recrew
Battery in the Units menu during that same phase. Note that only a cavalry regiment can recrew a
horse-artillery battery. 



When you Select Recrew Battery, the S# of the recrewing unit is reduced by 25 per gun of the
battery to be recrewed, and the battery’s uncrewed status is removed. Furthermore, in order to
recrew, the infantry unit must have at least 25 men remaining after recrewing. The battery’s Fa-
tigue level becomes the same as the recrewing units. Neither unit can move (the recrewing unit
could advance into Melee), and the battery cannot fire, until the next friendly Player Turn.

For artillery ammo supply rules, see Artillery Ammo, below. For artillery in Melee, see Melee
and Resolving Melee on p.49.

5.4  AMMO &
SUPPLY WAGONS
When a regiment incurs a deple-
tion of its ammo, it becomes “low
on ammo” and thereafter cannot
fire in its Offensive Fire Phase
until resupplied. If a regiment that
is already low on ammo incurs an-
other ammo depletion, it “runs out
of ammo” and can make no
Ranged-Fire attack at all until it is
resupplied.

For a unit to be resupplied, it
must be non-Routed and within
five hexes of a friendly supply
wagon. The path of hexes traced to
the supply wagon may not cross an

impassable creek hexside or pass through an enemy unit or its ZOC. If it does, the unit cannot be re-
supplied.

Each time a supply wagon resupplies a regiment, that wagon’s supply strength (“S#” in the Unit
List) is reduced by one. When its S# becomes zero, it is eliminated. Wagons themselves cannot be re-
supplied.

A supply wagon that incurs a loss due to an attack does not have its S# decreased, nor does
it become Disrupted or Routed. Instead, its “crew” is considered killed and the wagon becomes
immobile (i.e., its movement allowance becomes—and will remain—zero). An immobile sup-
ply wagon cannot be “recrewed”, but can continue to resupply friendly regiments. A supply
wagon captured in Melee becomes a supply wagon of the captor’s side.

Artillery Ammo
The artillery ammo supply of both sides is displayed in the bottom line of the Terrain Info Box (see
p.28). Each time an artillery battery makes a Ranged-Fire attack, its side’s artillery ammo supply is re-
duced by one. When a battery is eliminated in Melee, the artillery ammo level of the side that lost the
battery is reduced. When a side’s artillery ammo supply reaches zero, none of its artillery units can
fire. A side’s artillery ammo supply can only be increased through the arrival of artillery reinforce-
ments. Neither captured artillery nor its ammo can be used by the captor side.
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6.1  TERRAIN
The BATTLEGROUND: BULL RUN maps contain numerous types of terrain, each with an associat-
ed effect on movement, LOS, and combat. If you wish to inspect the terrain in a hex obscured by the
presence of units, Select that hex to put the Hot Spot there; then consult the Terrain Info Box, or Se-
lect the “toggle units” Toolbox button (or the Units Off command in the Display menu). If using the
3D map, you also have the option to Select the “toggle unit bases” Toolbox button or the Unit Bases
Off command in the Display menu.

A terrain key summarizing the effects of the various terrain types follows. The +/– number in the
Combat Effect column alters the Ranged Fire dice roll if the Target is in that terrain type; see Resolv-
ing Ranged-Fire on p.48. Terrain Combat Effects are cumulative for Ranged-Fire purposes, but the
only Terrain Combat Effect that can apply to Melee are those for breastwork, stone wall or embank-
ment. For Movement Cost purposes, cavalry in line formation (i.e., dismounted) are considered “in-
fantry”; in the chart that follows “cavalry” refers to mounted cavalry.

CLEAR
Movement Cost: 2 (supply wagons: 3)

LOS/Combat Effects: none

FOREST
Movement Cost: 4 (infantry in line or column);

6 (cavalry); 8 (artillery and supply wagons)

LOS Effect: Based on elevation; forest hexes have a height of 50 feet on all maps.
Combat Effect: –1

TERRAIN KEY
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ORCHARD
Movement Cost: 3 (infantry); 
4 (cavalry); 6 (artillery and supply wagons)

LOS Effect: Based on elevation; orchard hexes have a height of 15 feet.
Combat Effect: none

TOWN
Movement Cost: 4/1 (infantry line/column);

2 (cavalry, artillery, supply wagons); non-column units be-
come disrupted

LOS Effect: Based on elevation; town hexes have a height of 30 feet.
Combat Effect: –1 

MARSH
Movement Cost: 4 (infantry); 8 (cavalry); 
causes automatic disruption when entering;
Artillery and supply wagons cannot enter

LOS/Combat Effects: none 

In BATTLEGROUND: BULL RUN, certain terrain features appear along hexsides. These features
can be viewed by clicking in the Terrain Info Box. Below is a list of the hexside terrain features.

STREAMS
Additional Movement Cost: +1 (Infantry);      +2 (all
other units)

Special: The extra movement cost to cross a stream is ignored if the unit crossing it qualifies for the
pike/road/trail movement benefit (see below). 

CREEKS
Additional Movement Cost: none; crossable only at
bridges or fords (ford = stream hexside)

Special: Creeks are a darker blue than streams, and can be
crossed only at a bridge or ford (where the hexside art becomes stream art to allow units to ford it).

BRIDGES
All units can use a bridge; however, infantry in line and dis-
mounted cavalry must change Formation to column or
mounted respectively before such a unit can use a bridge to
cross a creek.

Hexside Terrain Features
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PIKES, ROADS, RAILS & TRAILS
There are a number of pikes, roads, rails and trails that wind
their way across the scenario maps. Below is a listing of
their movement effects: Most units (except infantry in line
and dismounted cavalry; see 
below) moving  along a road or pike pay one
movement point per hex (regardless of terrain).
Supply wagons pay two movement points per road
hex. Infantry in line and dismounted cavalry pay
the normal terrain movement cost of the hex. All
units
(except infantry in line and dismounted cavalry)
pay two movement points to move along a rail or
trail. Infantry in line and dismounted cavalry pay
the normal terrain movement cost of the hex

.

IMPORTANT: Only one non-leader unit can receive a trail or road movement bonus at
a time.

EMBANKMENT  (“The Unfinished Railroad”)
Movement Cost: +1 (infantry); +3 cavalry; 
+6 (artillery and supply wagons)

Combat Effect: –2 (ranged fire, and Melee if attacker
crossed embankment hexside)
IMPORTANT: Only units in the embankment hex receive the embankment modifier.

BREASTWORKS
Movement Cost: 1

Combat Effect: –1(ranged fire, and Melee if any attacker crossed breastwork hexside)
Breastworks can be constructed by infantry regiments and dismounted cavalry regiments during

play. To start construction, during a friendly Movement Phase Select the unit and then Select Make
Breastworks from the Units pop-down menu. To stop construction, follow the same procedure again
during a friendly Movement Phase. 

At the start of each Player Turn, the program checks to see if each friendly unit meets the con-
struction qualifications, which are:

• The unit must be infantry or dismounted cavalry; 
• It cannot have moved (including Facing/Formation change), attacked or been attacked in any

way, or been in non-Good-Order status, at any time during the two preceding Player Turns.
If these conditions are met, the program makes a die roll based on an inherent probability. If the die
roll is successful, a breastwork appears along the hexside the unit directly faces (unless one already
exists there or the unit is facing a wall hexside).



A unit constructing breastworks has a “pick-and-shovel” icon displayed in the icon area of the
Unit List. While this icon is visible, the unit cannot recover from Fatigue, and if it fires it does

so at half strength (and loses its “constructing” status).

ELEVATION LEVEL
Each elevation change represents 30 feet

Additional Movement Cost:*
(From lower to higher: +1 (infantry); +2 (all non-infantry
units)
(From higher to lower: +1 (all non-infantry units moving
down slope).

Combat Effect: –1 for Ranged Fire if target is one level
higher than firer, or –2 if target is two or more levels higher than firer. In melee, the modifier is equal
to the most levels ascended by any attacking unit.

6.2 VICTORY CONDITIONS
Each scenario has its own set of Victory Values, which are point values that determine victory. They
can be viewed via the Victory command in the Status menu. Using this command causes the Victory
Dialog to appear, which lists a variety of data. It shows the number of men/cannons each side has lost
so far and their point value. It also names the side the victory conditions apply to (calling it the First
Side), the total point value of all Objective hexes that side currently controls, and that side’s current
overall point total (which the program calculates by subtracting the value of its unit losses from the
sum total of its controlled Objectives plus the enemy’s losses).

Any of five levels of victory are possible for the First Side: Major Defeat, Minor Defeat, Draw,
Minor Victory and Major Victory. Each has an associated number of points which that side must
equal or exceed at the end of play in order to achieve the next-higher level of victory. 

Specifically:
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• The First Side suffers a Major Defeat if its point total is less than or equal to the total listed for
“Major Defeat” in the Victory Dialog.

• The First Side suffers a Minor Defeat if its point total is greater than the total listed for “Major
Defeat”, but is less than or equal to the total listed for “Minor Defeat”, in the Victory Dialog.

• The First Side achieves a Draw if its point total is greater than the total listed for “Minor Defeat”,
but is also less than the total listed for “Minor Victory”, in the Victory Dialog.

• The First Side wins a Minor Victory if its point total is greater than or equal to the total listed for “Minor
Victory”, but is less than the total listed for “Major Victory”, in the Victory Dialog.

• The First Side wins a Major Victory if its point total is greater than or equal to the total listed for
“Major Victory” in the Victory Dialog.

The program takes the First Side’s current overall point total, finds which level that total equates
to, and displays that level’s name as the side’s current level of victory.

A scenario does not automatically end
when one side achieves a Major Vic-
tory (or suffers a Major Defeat); the
level of victory may change during
the course of play as casualties occur
and Objectives change hands. Only
the level that exists at the end of the
scenario applies for determining the
winner. However, the scenario will
end if all units from one side have
been eliminated and the opponent has
all the objectives.

Objectives
As the name implies, an Objective is a
vital hex to control in a scenario due
to its victory-point value. All Objec-
tives are controlled by one side or the
other at scenario start. To gain control
of an enemy-controlled Objective,

you must occupy it with one of your own units. By themselves, leaders, supply wagons, and routed
units can’t be used for this purpose.

To display all Objectives on the map, Select Objectives in the Display menu. When
this command has a check mark next to it, each Objective hex is marked with a flag
icon to denote its location and ownership. 

To find the point value of a specific Objective hex, Select Objectives in the Status
menu. Selecting one of the Objective-hex lines in the dialog box that appears will move the Hot Spot
to that Objective hex.



6.3  USING THE A/I
When the A/I is conducting an action, the A/I Action Dialog appears to tell you what the A/I is doing,
and the map will scroll to bring the corresponding action.

The A/I Action Dialog has four buttons: Step,
Run/Pause, Cancel and Help. The Step button is ini-
tially the default. The current default button is outlined
in black, meaning that it can be chosen by pressing
Enter while the dialog is on-screen.

The Step button runs the A/I for one action, after
which A/I processing halts. 

The Run button makes the A/I run continuously until there are no more A/I actions for the cur-
rent phase. When you Select Run, it changes to Pause (which becomes the default).

The Pause button halts the A/I temporarily. (While the game is halted, you cannot Select any-
thing from the Menu Bar or Unit List—but the Toolbox and other A/I Dialog buttons remain active.)
When you Select Pause, it changes back to Run (which becomes the default).

The Cancel button cancels A/I processing. (When you Select Cancel, it becomes the default.) To

re-activate the A/I, Select the “Activate A/I” button in the Toolbox or the Activate A/I command in
the A/I menu. While the A/I is activated and the A/I Action Dialog is on-screen, the Esc (Escape)
key acts as a Cancel button.
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Note: When the A/I for the side conducting the actions in the current phase is set to Manu-
al, you can Select the Activate A/I menu command (or its corresponding Toolbox button)
at any time to have the A/I complete that phase for you. Also, the type of A/I being used

(Commander Control, Automatic, or Automatic with Fog-of-War) can be changed via the A/I menu
at any time for either or both sides [Exception: if playing a modem-to-modem,internet or PBEM
game, Fog of War cannot be turned off once the game has begun].
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Commander Control & Organizations
Selecting the Commander Control command in the A/I menu at the start of the scenario lets you
issue orders to one or more leaders (and thus to the units under their command). If you choose this,
the Leader Selection Dialog will appear, from which you must Select the leader(s) you wish to con-
trol. (To choose more than one, hold down the Ctrl or Shift key as you Select each name.) 

Afterwards, an Order Dialog for each
of your leaders will appear at the start
of his friendly Player Turn. This dia-
log shows the order his superior has
issued to him (unless he is the army
leader)—which you can change if
you wish—and allows you to issue
orders to his subordinate leaders (and
thus to their regiments and/or batter-
ies). “Location” shows the coordi-
nates of the hex the named leader
presently occupies. “Size” indicates

the highlighted organization’s current strength. “Health” indicates the percentage of units in that orga-
nization that are in Good Order, crewed if artillery, and not suffering from High Fatigue.

To give an organization an
order, Select its name and
then Select one of the orders
from the list in the dialog.
Then choose the organiza-
tion’s “objective” for the turn
by right-clicking on the ap-
propriate hex. Once you’ve
given orders to all your orga-
nizations, Select the OK but-
ton and play will proceed. 

If you click the Cancel button in the Order Dialog, A/I processing is canceled at that point. Pro-
cessing can be resumed by Selecting the “Activate A/I” button in the Toolbox or the Activate A/I
command in the A/I menu.

Summary of Commander Control A/I Order Types
Attack (Extreme). An “extreme” attack order will cause units to attack in a more concentrated for-
mation with maximum stacking in each hex. Also, extreme order will cause units not to fall back
until all units of that organization are no longer in Good Order.

Attack Order. A regular attack order causes units to move so as to take the specified objective. For
division or higher organizations, flank units will be deployed in an advanced position.

No Order. If you don’t want to give an order to a formation, select “No Order”. While a unit will still
fire at a close range target, it will not normally move.

Defend Order. Units will move so as to hold specified objective. For division or higher organiza-
tions, flank units will be deployed in a “refused” formation. 



Defend (Extreme). An “extreme” defend order will cause units not to fall back until all of the units of
that organization are no longer in Good Order.

Unknown-Unit Markers
When Fog of War is in effect for a side, its units are partially revealed—in the form of
Unknown-Unit markers—whenever an enemy unit becomes adjacent to them. An
Unknown-Unit marker indicates only the presence of a hidden unit; the actual type(s)

and number of units are not revealed until the start of the next phase. Aunits move automatically ends
when it reveals an adjacent Unknown-Unit marker.

6.4  GAME TURNS
Each scenario has a maximum number of playable Game Turns. When that number has been played
to completion, the game is over. The number of Game Turns is displayed in the Phase Box (see p.4).

6.5  THE SEQUENCE OF PLAY
Each Game Turn comprises two Player Turns—one Rebel and one Union. Furthermore, each Player
Turn is made up of four phases, which occur in the order listed below. 

For simplicity, the player whose side is “active” in each of these phases (aside from the Defen-
sive Fire Phase) is referred to as the Phasing Player. Except in the last Player Turn of the game, the
completion of each Melee Phase is followed by the Movement Phase of the next Player Turn, in
which the opponent becomes the Phasing Player. To advance the game to the next phase, Select either
the “advance to next phase” Toolbox button or the Next command in the Phase menu.

1. Movement Phase
In the Movement Phase, the Phasing Player may move some, all or none of his units that are capable
of movement. However, as the first action of this phase, the program finds all of the Phasing Player’s
units that are Fatigued, Disrupted, Routed, low on ammo and/or out of ammo, and checks to see if
each loses any Fatigue, is resupplied and/or Rallied.  The program also checks to see if any units that
are building breastworks have finished constructed them. It then announces on-screen, in the form of
the “Command Report”, the results of these checks.

2. Defensive Fire Phase
In the Defensive Fire Phase, the Phasing Player’s opponent may fire some, all or none of his units that
are capable of making a Ranged-Fire attack.

3. Offensive Fire Phase
In the Offensive Fire Phase, the Phasing Player may fire some, all or none of his units that are capable
of making a Ranged-Fire attack.

4. Melee Phase
In the Melee Phase, the Phasing Player may conduct Melees with some, all or none of his Melee-ca-
pable units that are adjacent to an enemy unit, or are adjacent to a Vacant Hex (see MELEE, p.49).
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6.6  MOVEMENT
The Phasing Player can move his units only during their Movement Phase, at which time he may
move all, some or none of them that are capable of movement (e.g., unlimbered artillery cannot move
from one hex to another, nor can an uncrewed supply wagon or fixed units). For a basic explanation
of how to use the mouse to move units, see MOVEMENT on p.7.

If more than one unit in a hex is currently Selected, you can move all of them using any
movement method just as if they were a single unit (within stacking limitations; see STACKING on
p.11). Note, however, that moving any stack of units, or entering a hex that contains even one other
non-leader unit, negates the benefits of moving along a pike, road or trail. For instance, if you try to
move two or more line-formation regiments simultaneously along a road, they must pay the non-
road cost of the hex they are entering. Likewise, if a unit already occupies a road hex and you at-
tempt to move another unit into it, the non-road cost will be charged. 

Each Formation change a (non-leader) unit makes, and each Facing change you invoke, costs
that unit a portion of its movement allowance; these costs are listed under Change Costs in Parameter
Data, which can be found by Selecting Scenario Notes in the Help menu.

If you move a unit but want to start its move over again, you can Select Undo Last Movement
in the Units menu or hold down the Ctrl key and press U on the keyboard, provided that unit is still
Selected [Exception: A move cannot be undone if Fog of War is in effect for the opposing side, if
playing via modem, internet or in a PBEM scenario].

If you move a unit but use only part of its movement allowance, you can move one or more other
units and still go back and finish moving the first unit. A unit can become the “leading” unit in column
movement even if it has already expended part of its movement allowance.

A unit’s movement allowance drops to “0” whenever it moves adjacent an Unknown-Unit
marker, or moves adjacent to a non-Routed enemy unit and is within that unit’s Field of Fire.

All the various types of terrain in the game have an associated movement cost, or provide some
kind of benefit or restriction to movement. See 6.1 TERRAIN for details.
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Reinforcements
Many of the scenarios have reinforcements, which are units that enter from off-map during play. You
can display the Scheduled Dialog to see when, where and how many reinforcement groups are avail-
able by Selecting Scheduled in the Reinforce menu. (However, you cannot see the opponent’s rein-
forcement groups if Fog of War is in effect.) Selecting any line in this dialog automatically scrolls the
map to the arrival hex of that reinforcement group and makes that hex the current Hot Spot. The per-
centage chance that the reinforcement group will arrive on the listed turn (or any turn thereafter if it
does not arrive on the first turn) is listed in the Scheduled Dialog. An asterisk (“*”) displayed before
the listing for a reinforcement group indicates that the group has been delayed (but is still in the queue
to enter).

At the start of a Movement Phase in which reinforcements have arrived, a message will appear in
the Command Report to alert you to their arrival. Double Clicking on the name of the Unit in the
Scheduled Dialog lets you view a list  of each unit of the reinforcement group.   The arriving units may
be brought onto the map at any time during the Movement Phase, or they may be ignored and brought
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on in a subsequent Movement Phase (i.e., they will remain available indefinitely until entered).

To bring on reinforcements, 

1. Select Arrived in the Reinforce menu to display the Arrived Dialog, which will show a list of
the available units. 

2. Double-click with the left mouse button on the name of a unit in the list. When you do so, the
dialog will disappear, the map will scroll to the entry hex and that unit(s) will appear there.  

3. If more reinforcements are available, select Arrived again, and repeat the procedure until
you’re done bringing on your reinforcements.

Protected Entry Hexes:
Most reinforcement entry hexes are “protected” such that enemy units within a particular

range of them will be automatically routed (or eliminated if in the hex!) when certain enemy rein-
forcements appear there. More details on this can be found by Selecting Scenario Notes in the
game’s Help menu, then Selecting 8.0 Arrival Schedule.

Fixed Units
Many of the scenarios of BATTLEGROUND: BULL RUN have Fixed units. Fixed units are
shown in the Unit List with a red “F” icon. Such units are frequently “released” automatically

during the scenario. The Release Dialog displays the turn the unit(s) is first eligible for being released
is shown, followed by the percentage chance of it being released. If not released on the first turn it is
eligible, a dice roll is performed at the start of each turn for that unit(s) until it is released. The Com-
mand Report at the start of a player’s turn will list units that have just been released. Fixed units are re-
leased immediately if fired on by an enemy unit or if they become routed. Units cannot be fixed dur-
ing play. When playing with Fog of War, the Fixed status of enemy units and their release schedule is
not known.

To view the Release Dialog, Select Released from the Reinforce menu and a dialog box similar
to the one shown below will appear. 

By clicking on a listing in the Release Dialogue box, all units of that organization will be highlighted
on the map.
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6.7  COMBAT
For the basics, see COMBAT on p.8. A supply wagon cannot attack; its S# is used only to show how
many units it can resupply (see 5.4 AMMO & SUPPLY WAGONS). The same unit can be attacked more
than once in the same phase [Exception: not in the Melee Phase]. However, a unit may make a
Ranged- Fire attack or advance into Melee only vs. a target that lies within that attacker’s Field of
Fire:

Ranged Fire
Ranged Fire uses a combination of the attacker's strength (S#), weapon type, and the range (in hexes)
to the target to determine the actual strength of the attack. All Disrupted units, and units firing in the
Offensive Fire Phase that moved in the preceding Movement Phase, have their strength factor halved
before any other modification (quartered if both apply). Infantry in column, mounted cavalry, Routed
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Field of Fire Diagram
The darker gray shading in these illustrations shows a
unit’s (an infantry regiment in line armed with muskets
with a range of “2” hexes) current Field of Fire. It can-
not attack (even to advance into a Melee) any unit that
lies outside this Field of Fire unless it first makes an ap-
propriate Facing change during its Movement Phase.
In addition, the unit’s Zone of Control (ZOC) is its front
3 hexes (shown by hexes marked with “X” in these il-
lustrations).

X
X

X

X X
X
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units, and those that are out of ammunition and/or have no valid target within their Field of Fire can-
not use Ranged Fire. 

Restrictions on Ranged Fire
Ranged Fire can be conducted against only one target unit at a time. If the target hex contains only
one unit the attack will be resolved automatically. If the target hex contains more than one potential
target, a Target Dialog will be displayed to let you Select one of those units as the target. A unit name
appearing in gray in the Target Dialog indicates the unit is suffering from low/no ammo if Fog of War
is not in effect.

LOS and terrain can affect the attack. Ranged Fire cannot be used vs. a target the firer has no
LOS to. Selecting either the “show LOS” Toolbox button or the Spotted Units command in the Dis-
play menu will highlight all units that have a LOS to at least one enemy unit.

No unit may conduct more than one Ranged-Fire attack per friendly fire phase. Selecting either
the “highlight fired units” Toolbox button or the Fired/Fought command in the Display menu will
highlight all units on the map that have attacked thus far in the current phase.

An easy way to fire artillery is via the “display Artillery Dialog” Toolbox button (or the Ar-
tillery Dialog command in the Units menu). Selecting either of these makes the Artillery Di-
alog appear, which lists all friendly artillery units that are capable of firing. To fire a unit using

the Artillery Dialog, first Select the unit’s name in the list, then right-click on the target hex. (Note that
when a unit in the Artillery Dialog is Selected, all of its potential targets are highlighted on the map.)
Once the unit fires, it disappears from the list and the next unit is automatically Selected, so all you
have to do to fire this next unit is to right-click again on a target hex. Aunit name printed in light gray
in the dialog means that particular unit currently has no eligible target.

Resolving Ranged-Fire
When a unit makes a Ranged-Fire attack, the program multiplies the attacker's strength points (25
men = 1 strength point) by a number derived from the attacker's weapon type and the range to the tar-
get. This value is then divided by four. That firepower value is then halved if the firer is Disrupted or
if the fire is taking place during the Offensive Fire Phase and the firer expended any movement points
in the preceding Movement Phase (quartered if both apply). Adie roll is then made which is modified
according to the following conditions (as applicable):

–1 If attacker's fatigue level is 4, 5 or 6

–2 If attacker's fatigue level is 7 or greater 

–x As per the defender’s terrain modifier

–1 If the quality of the firer is E or F (does not apply to artillery)*

+1 If the quality of the firer is Aor B (does not apply to artillery)*

+2 If the target is an infantry unit in column formation or limbered artillery



+2 If target unit is being Enfiladed

+4 If the target is a mounted cavalry unit

*Optional Rules “Quality Fire Modifiers”  enabled

The program uses the modified dice roll to determine the amount of casualties (strength point
losses) inflicted on the defender, and adjusts the latter’s S# accordingly. (See the Weapon Effective-
ness Table and the Fire Results Table in Parameter Data under Scenario Notes in the Help menu.)
Each attack is resolved before the next one is made.

The possible results of Ranged-Fire depend on the type of target unit:

Regiment: no effect; or a one-level increase in Fatigue; or a reduction in its S# (if reduced to “0”, the
unit is eliminated; see also Morale Checks on p.51).

Battery: no effect; or a one-level increase in Fatigue; or a reduction in its S# (if reduced to “0”, the
unit is eliminated; see also Morale Checks on p.51); or the destruction of the battery’s “crew” (which
leaves the guns abandoned). For casualty (and stacking) purposes, each gun = 50 men.

Leader: no effect; or a capture/wound/elimination. (See 5.2 LEADERS.)

Supply Wagon: no effect; or the destruction of the wagon’s “crew” from small arms fire; or reduc-
tion in S# from artillery fire (see 5.4 AMMO & SUPPLY WAGONS).

Melee
Each gun of an artillery battery is equal to 12.5 men when defending in Melee. A leader stacked with
a unit under his command increases the strength (i.e., differential) of his side by one in Melee, but any
additional friendly leader present in the Melee provides no further benefit. A leader can advance into
Melee only if accompanying a friendly regiment. Units cannot advance into Melee in excess of stack-
ing limits, nor if they are Disrupted or Routed.
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To initiate a Melee, 

1. First choose—using the right mouse button—an enemy-occupied hex adjacent to the unit(s) that
will conduct the Melee. 

2. Then Select each friendly unit (or stack of units) that will participate in the Melee and Select Add to
Melee in the Melee menu. (Selecting Show Differential in that menu will display the attacker’s cur-
rent strength advantage [“+#”] or disadvantage [“–#”] in the Melee.) 

3. Once you’ve added the desired attacking unit(s) to the Melee, resolve it by Selecting the
“resolve Melee” Toolbox button or the Resolve Melee command in the Melee menu. Adi-
alog will be displayed to give the results. Each Melee must be resolved before the next one

can be initiated. Lone leaders cannot Melee each other.

Semi-Auto Melee
You can also use “drag-and-drop” to conduct Melees; see Melee on p.9. Select an eligible friendly unit,
and “drag and drop” it onto the adjacent enemy-occupied hex you wish to Melee. Each time a new
unit(s) is added in this manner the Melee differential is updated and displayed.

Auto-Melee
You can have the program conduct Melee for you even if not using the A/I. To do this, hold down the
Alt key and right-click on an enemy-occupied hex adjacent to at least one friendly, Melee-eligible
unit. The program will find all units eligible to attack that hex, and will give their names, their loca-
tions and the attack differential. If you click OK, they will automatically attack the hex.

A/I Melee
Another option for conducting Melee is simply to Select the “activate A/I” Toolbox button. The pro-
gram will then conduct all Melees in that phase automatically.

Resolving Melee
To resolve a Melee, the program computes a Melee “differential” based on the attacking and
defending strengths. The differential is the attacker’s S# minus the defender’s S# divided by
100

Versus Gun Battery: Each gun of a battery defending in Melee is equal to 12.5 men. 

Versus Routed Unit: As part of the differential calculation, the strength of each Routed de-
fender in the hex is quartered. 

Versus Vacant Hex: If all defending units in a hex are eliminated during the Offensive Fire
Phase, a red triangle icon will appear in that hex to mark it as a Vacant Hex. Such a hex may

be attacked in the next Melee Phase, and the meleeing unit(s) will automatically occupy that Vacant
Hex without gaining any fatigue or becoming Disrupted.

Even though the advancing side is termed the attacker, both sides engage in Melee simultaneous-
ly; hence the attacker will also suffer casualties. To resolve a Melee, the program:

• Adds two to the differential if any attacking unit that advanced into the melee hex from a hex that
was not in any defending unit’s Field of Fire;

• Adds one to the differential if no attacking unit involved in the Melee fired during the preceding Of-
fensive Fire Phase;

• Subtracts one from the differential if any attacker involved in the Melee advanced into the hex
across a breastwork hexside;

• Subtracts two from the differential if any attacking unit involved in the Melee advanced into the hex
across a wall or embankment hexside (such that the defending unit would receive the embankment
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modifier if fired on by the attacker);

• Subtracts from the differential a number equal to the greatest number of elevation levels ascended by
any one regiment as it advanced into the Melee;

• Subtracts one from the differential if any attacking unit is suffering from Low Fatigue (fatigue of 4-
6), or two if any suffers from High Fatigue (fatigue of 7-9);

• Adds one to the differential if at least one leader is with the attacking unit(s), or subtracts one if at
least one leader is with the defending unit(s).

The program then “rolls” two six-sided dice and sums the result, and cross-indexes it on the
Melee Table with the final differential to determine the losses each side will suffer. Anegative-number
result in the Melee Table for a side indicates that side is the “loser” in the Melee. (You can view the
Melee Table by Selecting the Help menu, Scenario Notes and then Parameter Data.) 

Example 1: 225 attackers against 75 defenders = a differential of +1. If none of the attackers
fired in the preceding Offensive Fire Phase, the differential would be +2. If the attacking unit
was accompanied by a leader (and the defender has no leader present), there would be anoth-
er +1 to the differential, making it +3.

Example 2:  A 6-gun battery has a defensive strength equivalent to 75 men.

Melee—unlike Ranged Fire—can affect all units in the hex. In-hex terrain modifiers (such as
forest) do not apply in Melee.

All regiments and batteries (of both sides) participating in a Melee automatically become Disrupted
and have their Fatigue level increased by two, unless meleeing into a Vacant Hex. Additionally, each non-
leader unit of the losing side has its Fatigue level increased by one more. If the defending side loses a
Melee, its survivors are automatically retreated one hex by the program (and will have to undergo a
Morale Check; see Morale Checks below). If a unit must retreat but has no legal hex to retreat to, is an un-
limbered battery or its inherent movement allowance is “0”, it is eliminated instead. If a regiment ad-
vances into a hex containing only one or more enemy leaders, uncrewed supply wagons and/or uncrewed
batteries, it captures them automatically (captured leaders and batteries are eliminated; supply wagons are
taken over by their captor.) 

If the attacking side wins the melee, all surviving attacking unit(s) will occupy the contested hex;
all surviving defending units (if any) will be forced to fall back (assuming a retreat route is available
and the unit is eligible to retreat from melee).

Morale Checks
When a regiment or battery suffers casualties (i.e., has its S# reduced) due to combat but is not elimi-
nated or have its crew killed, the program rolls a six-sided die to make a Morale Check for it. If the
casualties were incurred during the Defensive Fire Phase, the Morale Check occurs at the end of that
phase. If the casualties were incurred during the Offensive Fire or Melee Phase, the Morale Check oc-
curs at the start of the next Player Turn.

In addition, each time a regiment or battery becomes Routed due to failing a Morale Check,
every friendly regiment and battery in its hex and those adjacent to it must take a Morale Check. 

Also, when a unit is eliminated by fire, one unit in the same hex is randomly determined  to
make a Morale Check.



The Quality of a unit is used as its “morale” for rout purposes. A Routed unit has a morale of
zero. The following cumulative modifiers can apply to the Morale:

+1 If the unit is stacked with any friendly leader

–1 If the unit is suffering from low/no ammo

–1 If the unit was already Disrupted

–1 If the unit was already suffering from Low Fatigue (4-6)

–2 If the unit was already suffering from High Fatigue (7-9)

–2 If the unit was fired on Enfilade

–2 If it is a night turn

The possible results of a Morale Check depend on whether the combat that caused it occurred in the
Defensive Fire Phase, the Offensive Fire Phase or the Melee Phase (the results of Morale Checks made at
the start of a Player Turn are displayed in the Command Report dialog):

Defensive Fire Phase: If the die roll is less than or equal to the unit’s Morale, it “passes” the Morale
Check and there is no effect. If the die roll is greater than its Morale, it “fails” and becomes Disrupted.

Offensive Fire Phase: If the die roll is less than or equal to the unit’s Morale, it “passes” the Morale
Check and becomes Disrupted. If the die roll is greater than its Morale, it “fails” and becomes Routed.

Melee Phase: If the die roll is less than or equal to the unit’s Morale, it “passes” the Morale Check
and there is no effect (though the unit is automatically Disrupted anyway, due to having engaged in
Melee; see p.50). If the die roll is greater than its Morale, it “fails” and becomes Routed.

Important: The Morale check conducted by the computer at the end of the Offensive Fire Phase is
not handled immediately after the phase. Instead, the computer keeps a record of all the Morale
check results of the Offensive Fire Phase and applies them after the Melee Phase.
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Disruption & Rout
When a unit is moving in line formation at night, it automatically become disrupted.

When a unit becomes Disrupted, a “D” icon appears in its area of the Unit List. A Disrupted unit
has its attack strength and movement allowance halved, and receives a –1 modifier for Morale Check
purposes.

When a unit becomes Routed, an “R” icon appears in its area of the Unit List, it
cannot attack, it defends at one fourth strength in Melee, and it has a morale of “0”
when conducting morale checks. Infantry in line change to column Formation, and
dismounted cavalry change to mounted, when they Rout. Mounted cavalry and
limbered artillery do not change Formation when they Rout, but their icon still
changes to the standard “running-man” icon to make them stand out better on the

map.

If a Routed unit suffers another Routed result, it loses strength; such units are termed “lost strag-
glers” in the Command Report that appears at the start of the next Player Turn.

Fatigue Rout. If a unit is already suffering from the maximum fatigue level of 9 incurs a combat ef-
fect that would normally cause a unit to gain further fatigue it must take a morale check. If it fails the
Morale Check, the unit will Rout..

Auto-Rout Movement. If a unit has Routed, the computer will automatically move that unit away
from the closest known enemy unit. This move will be indicated on the screen by arrows on most
map views (dots on zoom-out 2D map). After getting a handle on where your Routed units have been
moved to, you may click anywhere on the map and the arrows/dots will disappear. Afterwards, a
Routed unit cannot move closer to the closest known enemy unit and cannot initiate any type of at-
tack.

Leaders and Supply Wagons. Leaders and supply wagons neither Disrupt nor Rout. A Routed unit
cannot become Disrupted (except when it Rallies; see 6.8), and loses any Disrupted status it might
have had. 
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6.8  RALLY
In a Rally attempt, the program makes a six-sided die roll for each of the Phasing Player’s friendly
Disrupted/Routed units.

The Quality of a unit is used as its “morale” for rally purposes. If a unit is stacked with a leader
of the same or higher organization, the Leadership Rating of that leader modifies that unit’s morale. In
addition. the Leadership rating of a Corp, Wing, or Army Commander will modify the morale of
units under their command in adjacent hexes, except at night. If the leader’s Leadership rating (with
A=6, B=5, etc.) is higher than the unit’s Quality, his Leadership Rating is used as the unit’s morale. If
his Leadership Rating is the same or lower than the unit’s Quality, a +1 is added. At night, the morale
of unit for rally purposes is halved, with fractions rounded up. The possible results of a Rally attempt
are:

• If a Routed unit’s die roll is less than or equal to its morale, it Rallies (i.e., loses its Routed status and
becomes Disrupted—but cannot be returned to Good Order in the same turn).

• If a Disrupted units die roll is less than or equal to the applicable command value, it Rallies (i.e.,
loses its Disrupted status and returns to Good Order). Each Disrupted unit has a nominal Command
Rating of “1” for Rally purposes. If it is not Detached and its brigade leader is “in command”, its
Rally die roll will be successful if less than or equal to “1 plus the applicable Command Rating
modifier”. If its brigade leader is “not in command”, it will Rally only on a die roll of “1”. See Com-
mand Radius/Rating below for further clarification.

Command Radius/Rating
The Command Radius of a brigade leader is the maximum distance in hexes he can be from one of his
regiments and still be able to provide it with his Command Rating modifier. The Command Radius of
a division leader is the maximum distance in hexes he can be from his brigade leaders and still be able
to pass a Command Rating modifier to the latter. Army and Corps leaders have an unlimited Command
Radius.

Any unit (including brigade leader) outside the pertinent Command Radius of its/his superior of-
ficer is considered Detached, meaning that it/he can neither receive nor pass down a Command Rat-
ing modifier.

All Command Ratings, of a higher leader, are treated as being one lower than normal in a night
turn.



Rally Procedure. At the beginning of each Player Turn, the program determines each friendly
leader’s Command State (i.e., whether he is “in command” or “out of command”). To highlight the
leaders that failed their last command check, click the “D” button on the toolbar.

When a subordinate leader is determined to be “in command”, his Command Rating
changes in the Unit List for the current turn to reflect the Command Rating modifier he re-
ceived.

• Starting with the highest (the army) leader, a six-sided die roll is made. If the die roll is less than or
equal to his Command Rating (his “C#” in the Unit List), he is “in command”. 

• If the army leader is found to be “in command”, he automatically passes down to each of his corps
commanders a +1 Command Rating modifier to their Command Rating. 

• In turn, each corps commander found to be “in command” passes down a +2 Command Rating
modifier for each of his division commanders (because each time a subordinate is found to be “in
command”, the Command Rating modifier he passes down to his subordinates increases by one). 

• In turn, each division leader found to be “in command” will in turn pass down a +3 Command Rat-
ing modifier to each of his non-Detached brigade leaders. 

• In turn, each brigade leader who is found to be “in command” will pass down a +4 Command Rating
modifier to each of his Disrupted but non-Detached units. Whenever a leader is found to be “out of
command” (or is Detached), the modifier he passes down becomes “0”.

6.9  FATIGUE
Fatigue has an adverse effect on a unit’s strength in Melee, when conducting Ranged Fire,
and on its ability to avoid Routing when it takes a Morale Check.

Fatigue occurs in a regiment or battery in the following ways:

• If it suffers a Fatigue result (“F” result in the Fire Results Table) when attacked by Ranged Fire, its
Fatigue is increased by one (this can apply only once per phase);

• If it suffers casualties, its Fatigue is increased by one (this fatigue increase can apply only once per
phase regardless of the number of times the unit suffers casualties in that phase);

• If it engages (or is engaged) in Melee, its Fatigue is increased by two.The Fatigue is increased by
three if it loses the Melee. (Exception: vs. Vacant Hex or vs. Isolated unit; see p.50)

A unit whose Fatigue level (“FA” in the Unit List) is 0-3 suffers no adverse effects. A unit suffer-
ing from Low Fatigue (“FA” of 4-6) receives a +1 die roll modifier to each Morale Check it takes.
One suffering from High Fatigue (“FA” of 7-9) receives a +2 modifier to its Morale Checks. In addi-
tion, all Melee/ranged-fire attacks by units suffering from Low Fatigue receive a  –1 modifier; all
Melee/ranged-fire attacks by units suffering from High Fatigue receive a  –2 modifier. If a unit with a
Fatigue level of 9 receives any increase in Fatigue, it must undergo a Morale Check.

At the beginning of each friendly Player Turn, each Fatigued unit has a chance of reducing
its Fatigue by one if on the two preceding Player Turns it has not moved (including a Facing/For-
mation change), fired, fired upon, or participated in a Melee. This chance is increased at night.

When a unit is eliminated by fire, the fatigue loss is applied randomly to one unit in the same
hex.

If Fog of War is in effect for a side, the opponent cannot see the Fatigue level of that side’s
units.
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6.10 COMMAND REPORT FEATURES
At the beginning of each turn, the computer displays a Command Report dialog box. This command
report lists units that have been released, units undisrupted, units that have recovered from Fatigue, units
that have Routed, etc. Below is an example of such a command report. 

At the end of each Offensive Fire Phase, a Command Report is displayed indicating all units that
have been Disrupted due to defensive fire.

Once you have reviewed the information in the Command Report, you may continue the game
by clicking OK. 

6.11 OPTIONAL RULES
At the beginning of the game, in the A/I Selection dialog, the player is given the option to enable or
disable Optional Rules. To access the Optional Rules dialog box, select the Rules button in the A/I
Selection Dialog. These rules have been added to enhance gameplay for advanced players. Once se-
lected, these rules will remain the default settings for future games, and cannot be changed after the
start of a game.
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Select Optional Fire Results Table to use a separate results table for ranged fire in the scenario.
See the section on Optional Parameter Data in the Scenario Notes help file for more information.

Select Optional Melee Table to use a separate results table for melee in the scenario. See the
section on Optional Parameter Data in the Scenario Notes help file for more information.

Select Quality Fire Modifiers to have a +1 modifier added to a non-artillery units’ ranged fire
attack if the Quality of the unit is “A” or “B”, and a –1 modifier for non-artillery units with a Quality
of “E” or “F”.

Select Higher Fatigue Recovery Rates to have units with a low fatigue level (1-3) recover at five
times the normal rate, and units with a medium level of fatigue (4-6) recover at three times the normal
rate. Units with high level of fatigue (7-9) will recover at the normal rate.

Select Victory Points for Leader Casualties to gain victory points for leaders that are killed,
wounded or captured. Leader Casualty Points are displayed in the Victory Dialog.

Select Rout Limiting to apply a morale modifier when determining the spread of unit routing in
order to reduce the frequency of multiple-hex routing.

Select Quality Melee Modifiers to have a +1 modifier added to the differential of attacking units
in Melee with a quality of “A”or “B”, and a –1 modifier for attacking units with a Quality of “E” or
“F.” If the unit defending in Melee has a Quality of “A” or “B”, then a –1 modifier is applied to the
differential, and a +1 modifier if the defending unit has a Quality of “E” or “F.”

Select Isolation Rules to have units that cannot trace a line of hexes free of enemy units and un-
contested enemy ZOC to a board edge be considered Isolated. An Isolated leader receives no benefits
from his superiors during command checks. When an Isolated Artillery unit fires, there is a chance it
can become low on ammo or out of ammo with the same effects as infantry. The artillery unit be-
comes resupplied when it becomes non-isolated, provided the ammo level for its side is not zero. An
Isolated Unit defending in melee does so at 1/4 strength.

Select Extreme Fog of  War to hide each unit’s name and quality from the opponent. It’s strength
is given only partially; e.g., a 350-man unit would have a “3??” displayed as its strength. Leaders under
Extreme Fog of War have all data except their name hidden from the opponent. When a unit enters the
ZOC of an enemy unit, then the name of that unit is revealed.

Select Partial Retreats to allow units to retreat from melee, even when the retreat will cause over-
stacking in the retreat hex. Excess strength points are eliminated from retreating units.
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7.1  MODEM PLAY
Modem play allows two people to play the opposing sides in a scenario without having to be together
in the same place. All each player needs is an installed copy of the game, and a modem hooked up to
his computer and phone line.

To start a new scenario and play it by modem, first call your opponent on the phone, pick a sce-
nario to play, and agree on who will be the Caller and who will be the Host. The Host will be respon-
sible for opening and saving the scenario on his computer. The Caller has the option of providing an
encryption key at the start of the scenario to ensure that, when the scenario is saved, no one but the
Caller will be able to open the saved-game file later.

Each player should launch BATTLEGROUND: BULL RUN and, when the Menu Screen ap-
pears, Select Start Game as Modem Host or Start Game as Modem Caller as agreed on beforehand.
(If you’re presently viewing the Scenario Selection Screen, Select Previous to go to the Menu
Screen.)

For the Caller, a dialog box will appear, offering a choice of which game map to open. Be sure to
Select the correct one for the scenario.

For the Host, a dialog box will appear, asking him to Select whether a new or a saved game will
be played. Select a new game, and then the Scenario Selection Screen will appear. Then, Select the
appropriate scenario and the Play button.

Once the map and Modem Settings dialog box appear on-screen, the Host should configure his
modem port. The most important setting is Baud Rate. If you’re not sure what your modem’s baud
rate is, choose something conservative like 2400. If you have a 28.8 modem, select the baud rate
38400. The next most important setting is Port. A typical configuration is for the modem to be on
COM2 (if the mouse is on COM1), but you may have to consult your hardware documentation (or
use trial-and-error) to find your correct setting.

Once the map and Modem Settings dialog box appear on his screen, the Caller should configure
his own modem port. The baud rates need not be the same. The modems will negotiate the highest
rate both can handle.

Both sides now hang up the phone.

The Host clicks OK in the Modem Settings dialog box, and should see the Answer Dialog show-
ing that it is waiting for a call. He then waits.

The Caller clicks OK in his Modem Settings dialog box, and should see the Dial Dialog. He then
left-clicks in the phone entry line and types in the phone number of the Host system (i.e., the phone
number of the line connected to his opponent’s modem). He may also type in an encryption key now
(see 7.2). Lastly he Selects the Dial button or presses the Enter key, and the modem will call the Host.

7.0 MODEM, PLAY BY E-MAIL 
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The Host system should answer after the first or second ring.

Momentarily both players should see the Communications Dialog (a “chat window”). This may
be used by both players to type messages to each other. One or both players may close his Communi-
cations Dialog at any time during modem play. It will automatically reappear if the other side types a
message or, if due to a data transmission backlog, the number of messages waiting to be sent reaches
20. It can also be re-opened at any time by Selecting Communication Dialog in the Modem menu.

Immediately after the Communication Dialog appears, so will a dialog box enabling him to Se-
lect the side he has chosen to play and, if both players have agreed, Fog of War. Once he does this and
clicks OK, the scenario will be transmitted to the Caller. Only the player who goes first will see the
Phase Box that denotes the first Movement Phase of the game. He should left-click with the mouse
on the Phase Box to make it disappear, and he may then begin playing in the normal manner.

As the game proceeds, both players will see their own and enemy units fire and move in turn. As
each player completes a phase and advances the game to the next phase, the player who will be in
control for that phase will see the Phase Box appear. He should left-click on the Phase Box and pro-
ceed with his actions for that phase. The Status Bar at the bottom of the screen will show whether the
current phase is under Local (your) or Remote (your opponent’s) Control. During a phase that’s under
Remote Control you should not attempt to move or fire any units, but rather wait until you see the
Phase Box appear, indicating that you are now in control (i.e., it’s your phase to move or attack).
When the scenario is over, the Victory Dialog will be displayed for both sides to see.

If the game must be halted prematurely but the players wish to resume it later, the Host should
choose Save or Save As in the File menu and save the scenario. Both sides then simply exit the pro-
gram. Alternatively, after the Host saves the scenario he can Select Host and the Caller can Select
Caller again in the Modem menu; doing this will close the scenario without exiting the program.

ENCRYPTION KEY
While the Caller has the Dial Dialog on-screen prior to the start of play, he should enter an encryption
key (i.e., a password) in the appropriate spot in order to encrypt the saved-game file so that once it is
saved the Host cannot open it. (If no encryption key is entered at this time, the file can still be saved
later but it won’t be encrypted.) The Caller should pick an encryption key that will be easy for him to
remember but difficult for the Host to guess. It can be a word or a phrase, and numerals and/or punc-
tuation marks can be used.

The extension .btx indicates a saved-game file that has been encrypted using the Caller’s encryption
key. Encrypted scenario files are stored in a binary format, and the user should not attempt to view or print
them directly without using the BATTLEGROUND: BULL RUN program.

When re-opening a saved game, the Caller must specify the same exact encryption key that was
in use when the scenario was last saved.

RESUMING A SAVED MODEM-PLAY GAME
The procedure for doing this is the same as starting a new modem-play scenario, except that when the
Host is prompted to Select a new or saved game he must pick the latter. He then picks the agreed-
upon scenario in the ensuing dialog box.

If the scenario doesn’t open, the Host should check to make sure he Selected the right one. If
that’s not the problem, the Caller should Select New Encryption Key in the Modem menu and type in
the key again, for he probably entered it incorrectly the first time.
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7.2  NULL-MODEM PLAY
Null-modem play requires a direct cable connection between the two computers. Users should obtain
a suitable serial communication cable and a null-modem connector (available at computer supply
stores). Select Null Modem before Selecting Host or Client; that way, when Host or Client is Select-
ed, you will still be prompted for the correct port and baud rate, but no modem dialing will be done.
Note that under null modem, the exact baud rate for both machines needs to be Selected. Note also
that some older machines may not have serial ports that can handle speeds at or above 9600 baud, so
a lower rate may have to be used.

7.3 PLAY BY E-MAIL
1. Select the Special Options button from the Menu Screen.

2. Then Select “Play By E-Mail” from the Special Options window. 

3. You will then be asked “Do you want to start a new battle?” Select “Yes” if you are starting a new
game.

4. When the map appears, choose the local side (i.e., the side you will play) and whether or not
Fog of War will be used. You can also set the Advantage and any Optional Rules that will be in
effect, at this time. Then Select OK, and proceed with play. 

5. When the first phase under the control of the other side begins, you will see a message that local
control is over. You will be prompted to save the game (note that it must retain a “.bte” extension)
and E-mail the saved-game file to your opponent.

IMPORTANT!
The player starting a PBEM game must note which “module” the selected scenario is from

and convey this information to his opponent. After being transferred via E-mail and downloaded,
the PBEM game file must be kept in the corresponding BGR subdirectory on each player’s com-
puter. 

Please refer to your Windows® Tutorial Guide (supplied with your computer or packaged
with your original Windows® installation software) if you need instructions on transferring files.

Battleground: Bull Run Modules & Subdirectories
Module Name Corresponding Subdirectory

Blackburn’s Ford bbf

Brawner’s Farm bnf

First Bull Run fbr

Henry House Hill hhh

Second Bull Run sbr

Stoney Ridge sr
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To Resume a PBEM Game...

1. To resume a Play By E-mail game, you must download the file into the subdirectory that contains
the map used by that scenario.

2. Then double-click on the BATTLEGROUND: BULL RUN main program icon and select the
PBEM option from the Menu Screen.

3. You will then be asked “Do you want to start a new battle?”. Select No if you are resuming a
PBEM game.

4. When the “Battle Selection Dialog” window appears, Select the appropriate Module. All PBEM
games saved in that module (subdirectory) will be displayed in the bottom window. Select the
proper PBEM battle file and click the OK button. 

5. After the map and scenario are loaded, you will be given an option to see a “Replay” of your oppo-
nent’s most recent moves/attacks. After the Replay is finished (or if you choose not to view it), the
next phase begins and play resumes. At the end of local control, a prompt to E-mail the file will ap-
pear.

The same procedure is followed to play the remainder of the game, with each player alternate-
ly playing and E-mailing the game to his opponent.

7.4 TCP/IP INTERNET PLAY
To start an Internet Game...

Prior to beginning TCP/IP Internet Play, both players should ensure that they have a valid TCP/IP
connection established on their computers. Typically, this is a service of your Internet Service
Provider.

1. Select Modem HostorModem Caller from the MenuScreen.

2. Then Select Internet Connection.

3. The Modem Host should select a new scenario or resume a previously saved game. The Modem Caller
should select the corresponding module for the chosen scenario or battle.

4. ADialog will appear for the Modem Host listing the network address for their connection. Note: Typically
this address is changed by your Internet Service Provider each time an Internet connection is established.

5. The Modem Host should then provide the Caller with this address. This can be done by calling the Caller on
a separate line, sending the address by E-Mail, or by using an Internet “Chat” program. The Modem Caller
will then type this address into the network connection dialog. The caller can also specify an encryption key
at this time. The caller should then choose Connect on the Connection dialog.

6. At this point, both players will have a Communication Dialog and play will start or continue similar to stan-
dard Dial Up Modem Play. See Section 7.1.

NOTE: If you would like to view the Replay in other than the default “3D Zoom-Out” mode, you
can select “Cancel” when initially asked to view the Replay, then change the view mode to the
desired setting, then reopen the same file again.
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7.5 RECORDING BATTLES
The Record Battle feature of the Special pop-down menu allows you to record a scenario as you
play it. You can then “replay” this saved battle later by selecting Replay from the File pop-down
menu (see below).

Why would you record a battle? During a hotly contested scenario, you might anticipate that the
next few turns will decide the winner. You may want to keep a record of this and show it to someone
later, or (for your own satisfaction) review the moves you made to help improve your strategy for fu-
ture scenarios. 

You can record just a few turns of a battle, or an entire scenario. To record a battle,

1. Select Record Battle from the Special pop-down menu. Doing so places a check mark ( )
next to the feature. Immediately, a file window will appear allowing you to name this file (or
accept the default file name).

2. After naming the file, select OK to return to the game. From this point forward, all scenario
turns you play will be saved into this file.

You cannot record modem play or PBEM battles.

Note: The Record Battle feature is a toggle. At anytime during play, you can select the feature
again to turn it off. Anytime you start recording, it will overwrite any existing file of the same
name.

Replaying a Recorded Battle
When you want to view the turns of a recorded battle, simply select Replay from the File pop-

down menu and the recorded turns will automatically replay.

To halt the replay, press the Esc key. To resume the replay again, select Restart Replay from
the Special menu, and the recorded battle will resume where it left off.

Note: When you replay a battle that has been recorded with Fog of War in effect, the replay is from
the perspective of the other side.

EX: If you replay a battle that you played vs the computer, the replay will be from the perspective of
the computer (not your perspective). This means you’ll see what the computer “saw”.
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8.1 TERMS & DEFINITIONS
[Terms and abbreviations used in this manual are defined here for your convenience]

Adjacent: Two units or hexes that are directly next to each other on the map, with no intervening hex
between them.

A/I: Artificial Intelligence; the capability of the program to make decisions and conduct actions for a
given side.

Command Radius: The maximum hex distance at which a brigade or division leader can pass down
a Command Rating modifier.

Command Rating: A rating (“C#” in the Unit List) given to a leader, and used by him in his at-
tempts to Rally Disrupted units under his command. See also the definition of “Command Radius”.

Detached: A unit (usually a regiment) that is outside the Command Radius of its brigade leader, or
a brigade leader who is outside the Command Radius of his division leader.

Disrupted: A regiment or battery that is not in Good Order but is not Routed. A Disrupted unit fires
at half strength, and cannot advance into Melee.

Encryption Key: A “password” specified by the Caller in a modem-play game to keep the Host (the
Caller’s opponent) from opening the saved-game file.

Enfilade: A Ranged-Fire attack made from outside the defender’s Field of Fire, or made vs. infantry
in column.

Fatigue: A rating (“FA#” in the Unit List) given to a regiment or battery, and used by it for Morale
Check and Melee purposes.

Fatigue Rout: If a unit with a fatigue of 9 suffers a combat result that would susequently require it to
gain another point of fatigue it must undergo a Morale Check.

Field of Fire: The 120° arc through which a regiment or battery can fire. See also the definition of
“Enfilade”.

Fixed Unit: A unit that begins a scenario unable to move (usually for historical purposes). A Fixed
Unit is marked with an “F” in a red circle in the Unit List. For more information, see p.46.

Fog of  War: A game option that lets a player who chooses Fog of War for the opposing side see all
of his own (i.e., friendly) units, but only those enemy units that have moved/attacked while currently
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in the LOS of a friendly unit. When playing with this option in effect, the Fatigue level and Fixed sta-
tus of opposing units is also hidden.

Game Turn: Two consecutive Player Turns having the same turn number.

Good Order:Aregiment or battery that is neither Disrupted nor Routed.

Hex: Each hexagon on the map. Hexes are used for movement, range and LOS calculations. The
hexes are displayed/hidden via the Hex Outlines command in the Options menu.

Hot Seat Fog of War: A game option that allows two players to play a game on the same computer
without seeing the other player’s units. After a player has finished making his moves and/or attacks,
the program then draws a blank map and informs the player that it’s time for the opposing player to
take his turn (and occupy the “hot seat”). 

Hot Spot: The red square- or rectangular-shaped indicator that appears on the map. The hex currently
containing the Hot Spot is known as the Hot Spot hex.

Isolated: A unit which begins its turn surrounded by enemy units, enemy ZOC, and/or impassible
hexes or hexsides will be listed as “Isolated” in the Command Report dialog box. Such a unit is indi-
cated by having its S# in the Unit List printed on a red background. While Isolated, a unit may still
conduct ranged fire and Melee normally. If attacked in the Melee Phase it defends at 1/4 of it’s
strength.

Leadership Rating: A rating (“L#” in the Unit List) given to a leader, and used by him in his at-
tempts to Rally Routed units under his command.

LOS: Line of Sight; an imaginary line between units that the program uses to determine if they
can “see” each other. If the LOS is blocked (see the definition of “Obstacle”), they cannot see
(and hence have no LOS to) each other. The existing LOS to/from the Hot Spot hex can be
viewed via the Visible Hexes command in the Display menu.

Melee: An attack made from a hex adjacent to the defender during the Melee Phase, in which the at-
tacker can advance into that hex if the Melee eliminates all defenders in the hex or forces them to re-
treat.

Menu Bar: The line in the screen display immediately above the map, which contains the titles of the
various pop-down menus.

Morale Check: A die roll made by the program for a unit that has taken casualties due to an attack,
or that is in the same hex as (or is adjacent to) another friendly unit that becomes Routed. The possi-
ble results are No Effect, Disruption or Rout; see Morale Checks on p.51.

Objective: A scenario-specific hex with an assigned point value used to help determine victory and
defeat in a given scenario.

Obstacle: Terrain that can block LOS through its hex. Forest, Hill, Marsh and Orchard hexes can
block LOS, depending on the relative heights of the firer, the obstacle and the target.

Phase: Any of the four main segments of a Player Turn: Movement Phase, Defensive Fire Phase, Of-
fensive Fire Phase, and Melee Phase.

Player Turn: Each turn in which one side or the other is the “moving” side. See also the definition of
“Game Turn”.

Protected Entry Hex: Most reinforcing (non-leader, non-artillery) units have their entry hex “protect-
ed” in the sense that enemy units that are within a set range (usually from 3 to 5 hexes) of their entry
hex when the units enter will be routed, or eliminated if in the hex.  See also “Protected Entry Hexes”,
p.46.

Quality: Arating (“QL#” in the Unit List) given to a regiment or battery, and used by it when it takes
a Morale Check or tries to Rally. 

Rally: Adie roll made by the program for each of the Phasing Player’s Disrupted and/or Routed units

Battleground: Bull Run64

Appendix



at the start of each friendly Player Turn. If successful, a Routed unit becomes Disrupted, and a Dis-
rupted unit is returned to Good Order.

Ranged Fire:Any non-Melee attack made by a unit.

Rout: A unit becomes Routed whenever it fails a Morale Check caused by either an attack or by the
Routing of another friendly unit in a nearby hex.

Scenario: Each of the  specific battles that are listed in the Scenario Selection Screen.

Select: To click on an item using the left mouse button.

S#: For a regiment or battery, the basic strength (which equals the total number of men or guns) used
when it makes an attack. For a supply wagon, the number of units it can resupply. The S# is displayed
in the Unit List, and can change during play (i.e., it decreases whenever the regiment/battery takes ca-
sualties or when the supply wagon resupplies a unit. If the S# is displayed in yellow it indicates a unit
that is no longer at full strength.

Stack: The collective name for two or more units in the same hex.

Status Bar: The line at the very bottom of the screen display, which contains the current time of day,
phase, and hex coordinates of the Hot Spot.

Stragglers: ARouted unit that suffers another Routed result loses one or more strength factors (as de-
termined by a die roll made by the program); such units are termed “lost stragglers” in the Command
Report that appears at the start of the next Player Turn.

Strength Factor: See the definition of “S#”.

Unit List: The portion of the screen display immediately below the map, listing the data pertaining to
each unit in the current Hot Spot hex plus a representative drawing/portrait of the unit.

Vacant Hex: A hex in which all occupying units were eliminated by Offensive Fire. Such a hex can
be “meleed” by adjacent units in the following Melee Phase without gaining fatigue or becoming dis-
rupted.

Zone of Control (ZOC): Each land combat unit exerts a ZOC into the front three hexes it is facing.

Battleground: Bull Run 65

Appendix



Battleground: Bull Run66

Appendix

8.2 HOT KEYS
Ctrl-N: Advance to next phase

Ctrl-U: Undo last movement

Ctrl-X: Advance to next stack

Shift: Displays on the map the names of various geographical features

Esc: Cancels A/I processing while the A/I is activated and the A/I Action Dialog is on-screen

Left Arrow: Scroll map to the left

Right Arrow: Scroll map to the right

Up Arrow: Scroll map up

Down Arrow: Scroll map down

F1: Invoke general Help

F2: Invoke Scenario Notes Help

F5: Slow down the scrolling of the AI action dialog

F6: Return to normal scrolling of the AI action dialog

F7: Speed up the scrolling of the AI action dialog

The following hot keys can be used to move units from one hex to another:

Keypad 1: Move Selected unit(s) down and left to next hex

Keypad 2: Move Selected unit(s) down to next hex

Keypad 3: Move Selected unit(s) down and right to next hex

Keypad 7: Move Selected unit(s) up and left to next hex

Keypad 8: Move Selected unit(s) up to next hex

Keypad 9: Move Selected unit(s) up and right to next hex

The following hot keys can be used to move units within their hex:

Keypad 0: Change Formation of Selected unit(s)

Ctrl-B or End: Move Selected unit(s) backward in hex

Ctrl-F or Home: Move Selected unit(s) forward in hex

Ctrl-L or Delete: Change Facing of Selected unit(s) one hexside counter-clockwise in hex

Ctrl-R or Page Down: Change Facing of Selected unit(s) one hexside clockwise in hex
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AUTHENTIC MUSIC 
OF THE 

CIVIL WAR
by Bobby Horton

Most of the really fine music you’ll hear while playing BATTLEGROUND:
BULL RUN are tunes by the talented Bobby Horton. But these are just a small sam-
pler of the authentic tunes he has recorded, most of which are available on CD and
audio cassette. Some of his recordings were even used in the now-famous Civil War
series by Ken Burns that aired on PBS.

Each CD and audio cassette (with the exception of the “Homespun Songs of the
Christmas Season”) comes complete with historical liner notes about the songs. Most
of the songs were recorded with “period” 19th century instruments (or authentic repro-
ductions), and recorded in “period” style arrangements. His songs are truly a “labor of
love” (one reason, perhaps, why they go so well with this TalonSoft game!).

If you’re interested in hearing more of his songs, TalonSoft encourages you to
contact Mr. Horton (see under picture).

CURRENTLYAVAILABLE
Homespun Songs of the CSA CD Cassette

Volume 1 yes yes
Volume 2 yes yes
Volume 3 yes yes
Volume 4 yes yes
Volume 5 no yes

Homespun Songs of the Union Army

Volume 1 yes yes
Volume 2 yes yes
Volume 3 no yes

Homespun Songs of the Christmas Season no yes

Homespun Songs of Faith, 1861-1865 no yes

Each CD is $15; each audio cassette sells for $10. 

Also available is “Music & Memories of the Civil War” on video cassette.
Produced by PBS and Bobby Horton, this sells for $25 plus $3 shipping and
handling.
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TECHNICAL SUPPORT
If you have a technical problem concerning the operation of our software, please contact our

technical support staff. When you call, be at your computer if possible and have the following in-
formation ready: computer type, Windowsâ version, available hard drive space, total RAM,

type of video card, and a list of options you choose when you installed the game.

TECHNICAL SUPPORT: (0)181-343 9143 9.30-6.00pm

If you have a modem and would like to contact us on-line, you will find us:

E-mail us at:  support@empire.co.uk


